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projects@BU Login 

projects@BU Login Page (Internal Users Only) 

For Boston University employees, you will need to log into projects@BU using your Kerberos Username 
and Password. 

1. Navigate to the URL: https://bu.pmweb.com/PMWeb  
2. Click on the link stating, “If you are a member of the BU Community click here to use your 

BU login credentials (Kerberos). 

 
3. You will see a standard Boston University Login Screen 

 
4. Enter your BU Username and Password 



4 | P a g e  
 

5. Click the “Continue” button. 
Note: projects@BU has a timeout feature on the site.  If you have not SAVED any 
information in projects@BU for two (2) hours, the system will automatically log you out, 
though you will not notice this until you try and click on something. 

6. Once you have been auto logged out you will be returned to the default projects@BU login 
page.  To return to the KERBEROS page, simply refresh your browser window. 

 

projects@BU Login Page (External Users Only) 

For non-Boston University employees, you will need to log into projects@BU using your case-sensitive 
email address and password provided to you in the welcome email. 

Logging into projects@BU (PMWeb) 

1. Navigate to the URL: https://bu.pmweb.com/pmweb 
2. On the left-hand side of the page, locate the User Login Section. 

 

User login box indicated 

3. Enter your email address into the “User” box, and the password provided to you in the 
“Password” box. 

4. Click the “Login” button. 

Updating your Password in projects@BU (PMWeb) 

Follow these steps to update your password from the default (external users only). 

1. In the left-hand menu of the page click the Profile icon. 
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2. In the Login section of that page enter “pmweb2” as your Old Password (1) then a new 

password twice in the New Password (2) and Confirm Password (3) boxes. 

 

3. Click the “Save & Exit”  button at the top of the page to return to the projects@BU 
home page. 
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projects@BU General Navigation and Tips 

projects@BU Home Page 

The Home page is visible both when you first log in to projects@BU or click the PMWeb button. Simply 
click the PMWeb Logo and you will be brought back to the Controls or last visited Tab. The menu bar 
contains the eight modules that make up projects@BU (Planning, Engineering Forms, Cost Management, 
Scheduling, Asset Management, Workflow, Portfolio, and Toolbox).  Below these are the Profile, Recent 
records, and Exit buttons. 

  

projects@BU Home page 

The Profile pop up menu allows quick access to update your Event Reminders, pin reports to your home 
page, and adjust your general options. 

   

projects@BU Profile 

One option that is recommended is that you turn on “Prompt to Save when Navigating Away From 
Records.” 

    

Prompt option indicated 
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Turning this option on sets it so that the system reminds you to save if you attempt to leave a page that 
you have been updating without saving first. 

Controls Tab 

Upon Login, the Controls tab is the first you see. It contains a list of Workflows and Notifications that 
need your attention.   

 

Controls Tab and other Home Tabs 

Workflow Inbox 

The Workflow Inbox contains records that are waiting for your review or approval. To immediately access 
the record, click the grey hyperlink in the Record field. 

 

Workflow Inbox  
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General Terms and Navigation 

General Terms 

This guide makes use of several terms that are defined here to help with understanding the processes 
that follow. 

Term Definition 

Module Modules are the major sections in projects@BU, in the main menu on the left hand 
side. For example Planning, Engineering Forms, and Portfolio are all Modules in 
projects@BU. 

Record 
Type 

A Record Type is a section of one of the modules. For instance in the Planning 
Module, Initiatives and Estimates are both Record Types 

Record A record is a single instance of a record type within projects@BU. For instance in the 
Planning Module, a record would be an individual Estimate. 

General System Elements 

projects@BU’s page design incorporates several common elements.  This guide refers to them to help 
Users navigate through the various tasks and pages in the system. 

General Navigation 

Main Menu 

The Main Menu is on the left of every page in projects@BU, it is divided into the Module 
Sections,  Personal Controls, Recent Locations, and Exit Button.  When you click on a Module, a 
box pops out over your current view with the listing of the Record types.  Clicking one of these 
names navigates to the record in the system. 
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Main Menu 

Header Bar 

The Header bar is at the top of every Record Type or Record page.  The buttons available change 
depending on if you are on a Record Type or individual Record page.  

 

Header for the project record list. 

 Breadcrumb Bar – This shows a breadcrumb list of locations in projects@BU showing 
your location in the system.  
Ex: (Portfolio) > Portfolio > Records > PROJECTS – this indicates that this image was 
taken on the main Projects page. 

 The list header contains several common features: 

o Recent  – Click this button to bring up a list of your recently accessed records 
for this record type.  For example if you are viewing the Project list, clicking this 
button will bring up a list of the recently accessed Projects. 

o Programs – This is a drop-down list of all the Programs (Academic or Business 
Units).  Selecting one filters the list of Records by that Program. 

o Projects – This is a dropdown of all Projects in projects@BU that you have access 
to.  Selecting a Project in this list filters the list by that Project. 

o + – Click this button to add a new instance of that record (Estimate, Schedule, 
Project Request). 
Note: Depending on your access level to that record you may not see the add 
button. 

o Refresh – Click this button to refresh the list of Records, and display newly created 
records in the list. 

o Layouts – See the “Sorting and Filtering” section of the Guide for a description of 
the use of this button.  

Record Header Bar 

   

Example Record Header bar from the Project Module 

The Record header bars have several common features, as well as record-specific options. 

 List view  – Click this button to return to the list view. 

 Recent Records  – Click this button to bring up a list of your recently accessed records 
for this record type.  For example, if you are viewing the Project list, clicking this button will 
bring up a list of the recently accessed Projects. 

 Record selector – This is a list of all Records of this type that you have access to.  You can 
quickly select a record from this list.  
Note:  Clicking the down arrow next to this button shows a small menu that also contains the 
Copy command. 

 Save  – Click this icon to save the current record. 

 New  - Click this icon to create a new record. 
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Note 1: Creation functionality is not always available for all records, and is based on your 
access level to the system. 
Note 2: Clicking the arrow next to this button brings up a sub-menu that allows you to copy 
the record. 

 Delete – Click this icon to delete the record. 
Note: Deletion functionality is not always available for all records, and is based on your 
access level to the system. 

 Link Schedule – This button is Disabled 

 Print – Click the arrow next to this button , then click “BI Reporting” from the drop 
down to run a report on this record type.  

 Generate – The down arrow next to this button opens a list of connected record types you 
can generate from the basic record type if you have permission, for example a Project from a 
Project Request 
Note: This button is not available on all record types. 

projects@BU Basics 

projects@BU is made up of multiple modules, each with individual tools that will be explained in the 
sections of the User Guide.  The instructions below apply to all modules, and will help you with general 
navigation of the site. 

 Selecting and Editing Fields 

In order to modify any of the lists of fields in the various modules throughout projects@BU, you 
must first select the lines that you wish to modify.  Selecting these lines can be done in several 
ways. 

Clicking and Editing 

(Recommended for editing Individual Fields) 

1. Click the line that you wish to edit. 

 
2. Click the “Edit” button at the top of the list to begin editing the line, or double click the line.  

 
3. The line will turn yellow and the data fields can now be edited. 

 
4. Enter your changes into the line. 

 
5. Click the “Update Records” button once you are complete. 
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Double-Clicking 

(Recommended for editing Individual Fields) 

Double click the line that you wish to edit. 
Enter your changes into the line. 
Click the Update Records button once you are complete. 

Shift/Control-Clicking  

(Recommended for editing multiple fields at once) 

1. Click the first line that you want to edit. 
2. Either: 

 Hold shift and click the last in the set of lines that you want to edit. 

 Hold Control and click each line that you want to edit. 
3. Click the “Edit” button, and enter your changes into the line. 
4. Click the “Update Records” button once you are complete. 

Drag-Selecting  

(Recommended for editing multiple fields at once) 

1. Left-click and drag your mouse over the whole section of lines that you wish to select, and 
then release the mouse button.  (The lines you have selected will be highlighted in dark 
grey.) 

 
2. Click the “Edit” button, and enter your changes into the line.  
3. Click the “Update Records” button once you are complete. 
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Table Options in projects@BU 

Every Table and List in projects@BU can be easily sorted, filtered, and grouped by any of the columns of 
that table. Once a desired sorting is achieved, users can then save their “Layouts” in the system so that 
they do not need to re-do the sorting process upon each login. 

Attention: If you sort or filter columns after ordering they will revert back to the original order.  To keep 
your column order you must first save your current column order by creating a “layout” (see Creating a 
Custom Table Layout in projects@BU) 

Sorting, Filtering, Grouping and Reordering Tables in projects@BU 

Tables in projects@BU can be sorted or filtered by any column in the table.  Users are also able to adjust 
the order of the columns that appear in each table to better fit their needs. 

Ordering Columns 

To order any Column in projects@BU click and drag the name of the column, to another position 
in the table.  You can tell where the column will “land” by the two light grey boxes at the top and 
bottom of the column border. (see screenshot below). 

 

Note: Sorting or filtering will reset your column order back to the current “Default.” Which is 
whatever layout your currently have selected.  To keep your column order, you must first save 
your  

 

Sorting 

To sort by any Column in projects@BU click the name at the top of the Column, and the column 
will sort alphabetically.  To sort by reverse alphabetical order, click the name again and the order 
will reverse. 

            

Projects sorted alphabetically by Column Name. 

Filtering 

You can filter by any Column in projects@BU by first clicking the icon just below the name of any 
column, and then clicking your filtering method, for example Contains, Does Not Contain, or 
Equal To.   
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Filtering method 

Once the filtering method has been selected, enter the criteria you want to filter on into the box, 
and press enter.  The List will then update filtered by the criteria you chose. 

 

Projects filtered by names that Contain the word “New”. 

Grouping Tables in projects@BU  

Follow these steps to Group the Tables in projects@BU. 

1. Click and drag the Header of the Column, the name at the top, which you want to group your 
table by up to the white bar at the top of the table, where it says “Drag a column header and 
drop it here to group by that column.” 

Note: Make sure that your pointer is in the white bar at the top for the group to be 
created. 

 

Table view showing the grouping bar at the top. 
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2. Once you have dragged the header to the bar, the system will automatically group the table 
by that column. If you want to undo the grouping you can then drag the Column name back 
off the grouping bar and it will reset. 

Note: You can group by multiple columns at once, and they will be grouped in the order 
of columns that you chose. 

 

List of Estimates in projects@BU grouped by Estimate Status. 

Creating a Custom Table Layout in projects@BU 

Once you have sorted and filtered a table, you can then save that setup as a Layout in 
projects@BU, by clicking the “Layouts” button on the top of the table. 

1. Click the “Layouts” button. 

 

Layouts button indicated 

2. In the list that appears, click the “Save As” button. 

 



15 | P a g e  
 

Save as button 

3. In the “New Layout” window that appears, enter the name of your layout, and click the 
“Save and Exit” button. 

 

“Save and Exit” button 

Note: The new layout that you created is now set as the “Default” layout, to change your 
default layout, click on the “Layouts” button and click a different layout. 

Exporting the Current Layout to Excel 

After you have created your new Layout (or using the system default), you can export it to Excel, using the 
“Export to Excel” button at the top of the list page. 

   

This functionality can be accessed by: 

1. Navigate to any record type that you have access to. 
2. Ensure that the filters on the record are set correctly for the data set you want to export or 

remove all filters to export all records of that type you have access to. 
Note: Running a full export of all records you have access to will take some time to export. 

3. Click the “Excel” button   above the column names to start the export process. 
Note: Please do not navigate anywhere else in PMWeb until after the export has completed.  
Clicking on any record or record type while the export is working may cause unexpected 
behavior in the system. 

Creating Notes on Records in projects@BU 

All records in projects@BU have a Notes tab that allow users in the system to attach notes. 

Creating a Note 

1. From any record in projects@BU click the Notes tab. 
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2. Click the “+ Add” button at the top of the table. 

 
3. A box will open with the current date and your username automatically populated. 
4. In the Description field enter a title for your note. 

 
5. Type your note into the word box below. 
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6. Click the “Save and exit” button at the top of the window. 
7. To preview a Note that was already created click on the note in the list, and a preview of the 

note will appear in the box to the right. 

 

Previously created note with preview 

 

 

 

 

 

 

Document Manager 

projects@BU’s Document Manager tool acts as a central repository for all Documents for each Project.  
The Document Manager allows easy sharing of documents amongst the entire Project Team. (Note: 
Larger CAD files cannot be uploaded to the Document Manager.) 

The template Projects in projects@BU have a folder structure that is passed down to all Projects created 
using those templates.  This allows for a consistent folder structure and ease of locating any Documents. 
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All project documents should be loaded/saved into the document manager, and then attached to the 
record.  This allows for ease of searching, visibility, and reporting.  Attaching a document directly to a 
record does not meet this need. 

Uploading to the Document Manager 

8. In the Main Menu navigate to Engineering Forms > Document Manager.  

 

Engineering Forms > Document Manager 

9. When you open the Document Manager it will open to the last Project that you were looking 
at. 

Note: This view will default to the top level of the document manager if it is your first 
time viewing it, and the tree will show all Projects that you have access to.  You can limit 
the tree view by following the instructions in step 10 C below. 
 

 

Document Manager > Overview 

10. From here there are five different ways to access the Documents for your Projects. 
To find a Project that already has files attached to it: 
A. List Search 

i. Click the List Button to bring up the Document Manager file list. 
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List Button Indicated 

ii. In the “Project” Column of the file list, type in the name of your Project and hit enter. 
     

 

Project Column Indicated 

iii. Click Project name in the list to open up the top-level file in the Project Document 
Manager.  
B. Project List 

i. Click “DOCUMENT MANAGER” at the top of the page. 

 
ii. Double-click the “Projects” Folder.  A listing of all the Projects you have 

access to will appear. 

 
iii. Double-click the name of the Project, the double click the “Level 1-2” or 

“Level 3-5 Standard Folder Structure” file to open the top level of the folder 
structure. 
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Standard Folder Structure (List View) – Card view button indicated 
  

  

 

Standard Folder Structure (Card View) – List view button indicated 

    

C. To locate a Project that does not have any files attached, you can either select your 
project from the “tree” at the left of the window, or use the breadcrumbs at the top 
of the page to search for your project. 

a. To use the “tree view” 

i. Click the Options button  at the top of the tree window. 

ii. In the window that opens, uncheck the box next to All. 

 
iii. Navigate to the Program(s) or Project(s) that you wish to view and 

check the box next to them. 

iv. Click the “Save and Exit” button  at the top of the window to 

save your selections. 
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v. You can now navigate through the tree view to find the specific 
Project and folder you are looking for.  Your currently selected 
folder location will appear in the right side of the document 
manager window. 

b. To navigate using the “bread crumbs”: 
i.  Click the down arrow next to “Projects” in the top of the 

document manager window. 

 
ii. In the drop down that appears, enter either your project number, 

 

Or project name 

 
 

iii. Click the Project Name in the list and the Document Manager will 
automatically open on the top level of that Project’s folder 
structure. 

 
D. To search for a particular Project/File 

i. Type the name of the Project/File in the Search bar at the top of the page, 
and press the “Enter” key. 
Note: Unless you have renamed the folders in your project, do not search for 
a general folder name such as “01 Administrative,” or the search will pull up 
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all “01 Administrative” folders for all Projects that you have access to, and 
you will not be able to differentiate between projects. 

 

Search Bar 

ii. A listing of files with your search in their name will appear. 
Note: If you switch the search results to “List View” you can see which Project 
each returned folder/document is listed under. 

 
 

 

Document Manager view and Project List 

To enable details for all files in the folders, make sure the details switch is 
turned on.  When you click a file icon, a details window will appear on the right 
hand side of the screen. 
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Details window with details switch indicated. 

You can also revert to the older, list, view by clicking List View.  To get back to 
the new folder view, click Card View. 
If you click the Recent button, you will see a list of the latest files that you have 
accessed and can pull up any of them from that menu. 

Drag-and-Drop 

1. Locate the file on your computer. 
2. Navigate through the document manager to the folder you want to put the file in. 
3. Drag the file from the folder on the desktop to the PMWeb window and it will upload 

automatically. 

 

Dragging folder from your computer to PMWeb 

Browse and Upload 

1. Click the “File” icon in the center of the page, and a file navigation window will open. 
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Add button indicated 

2. Navigate through your folder structure to the file you wish to add. 
3. Click “Open” 

 
 
 
 
 
 
 
 
 
 
 
 

File Options 

1. Right-click on any file in the Document Manager to bring up the file options window. 

 

File options window 
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2. In this window you will have eleven options, detailed below 
i. View – View the full image file. 

ii. PMWeb Record – If this file has been attached to a specific record (Estimate, 
Engineering Form, Budget Request) this will open that record. 

iii. Download – Download the file to your desktop 
iv. Check In – If the file is checked out, update it and check it back in. 
v. Check Out – Check the file out so that it can be edited. 

vi. Cancel Check Out – Cancel the checkout 
vii. Bookmark – Add this file to your list of Bookmarked files to make them easy to find. 

viii. Copy URL – Open a window which has the direct URL to this file to be shared with 
anyone who has access.  

ix. Add – Add a new file/folder to this folder location. 
x. Copy/Move To – Copy or Move this file to a different location within the  

xi. Delete – Delete the file from the Document Manager 

Linking Documents from the Document Manager to a projects@BU Record 

1. Navigate to the Record you wish to attach the file to. 
2. Select the Attachments view. 

 
3. Click the + Add button. 

 
4. In the pop-up window click “From Document Manager” 
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5. In the window that opens, navigate or search through the document manager folder 

structure to the file(s) that you wish to attach. 

 

Folder navigation window 

6. Click the file. 

7. Click the “Save and Exit”  button to close the window and link the file to the Record. 
 

 

Workflows and Workflow Inbox 

Multiple record types including Budget Requests, Online Change Requests, and RFIs must all go through a 
Workflow approval process. 

Submitting a Record to Workflow 

Steps 

1. Click the “Workflow” tab on your record (for example Budget Request). 
2. Click the “Submit” button. 
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Workflow tab with “Submit” button 

3. In the “Comments” section type any comments or notes that you would like to provide to 
the next Approver in the Workflow. 

Note: These comments appear in the “Workflow Log” visible to all users who have 
access to the record. 

4. To send a copy of the workflow request to another user, type their email address into the 
Add CC field. 

Note: You can add multiple addresses to the “CC” to copy on the Workflow by 
manually typing in their emails, with a semi-colon (;) between the addresses. 

  

Comments and CC’ed Addresses Added to Workflow Tab  

5. Click the “Save” button to submit the Request to Workflow. 

 
Budget Request Example Workflow tab after pressing “Submit” button with “Save” button now showing. 

Note 1: Once the workflow has been submitted and saved to Workflow it cannot be 
modified unless it is sent back for revision by one of the Approvers in the Workflow. 
Note 2: You can check the status of the workflow request by viewing the status list in the 
“Business Process” section of the Workflow tab. 
 

Workflow Inbox 

The Workflow Inbox contains records that are waiting for your review or approval. 
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Completing a Workflow Action 

Follow these instructions to complete the step of the workflow(s) that you have been assigned. 

1. In the Workflow Inbox on the home page Controls Tab click on the Workflow Inbox link to 
open the whole list of Workflow steps you have been assigned. 

 
Workflow Inbox Indicated 

2. Click on the grey Document ID link to open the Workflow. 

 
 

3. The record will open with the Workflow tab selected. 
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Workflow Actions 

4. On the left side of the tab you will see a list of options. 
i. Approve – Approve the workflow and send it to the next step. 

ii. Return – Return the workflow for comment. 
Note: This does not stop the workflow progress, but simply returns it back to the 
previous approver or submitter. 

iii. Reject – Reject the request completely. 
Note: This option completely closes out the Workflow, and locks the record for 
editing.  In order for a Rejected request to be re-submitted a new, duplicate, 
record must be created and re-submitted. 

iv. Withdraw – Back the record out of Workflow.  The submitter can edit and re-submit 
the record for approval. 

v. Final Approval – This option is only available if you are the last step in the Workflow.  
This option closes out the entire Workflow and sets the status of the record to 
“Approved.” 

vi. Comment – Add a comment to the record. 
vii. Team Input – The blue team input link will allow you to send the request to another 

member of the project team for their input. 
Note: Team input does not allow the person to approve the workflow, only 
comment on it, and send it back to you for approval/rejection. 

5. Once you have selected an option a preview of the Email that projects@BU will send to the 
next person in the Workflow will be visible.  Next to this is a comments section where you 
can enter any comments for the next approver to read. 

 
Workflow email preview 

6. Once you have made your selection and entered any comments hit the “Save” button at the 
bottom of the selection to send the Workflow to the next person in the chain. 

Pinning Reports to your Home Page 

One of the most useful functions of the Home Page is the ability to “Pin” Reports from PMWeb to tabs 
that appear at the top of the page.  This makes these reports quickly accessible to you, rather than 
needing to navigate to the “BI Reporting” section of PMWeb and find them in there. 

1. Click on the “Profile” icon on the bottom left of the main menu. 
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2. In the window that opens, click on the “Home Page Settings” tab at the top of the window. 
3. Click the “+ Add” button at the top of the list on the “Home Page Settings” tab. A new line will be 

created at the bottom of the list. 
Note: Depending on how many tabs you have already “pinned” you may need to scroll through 
the list to find your new line.  The line can be identified with the title:  

4.  
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Project Requests 

Creating a Project Request and Submitting to Workflow 

Project Requests are submitted in projects@BU for review and approval by the appropriate entities.  
These Project Requests can be entered by anyone permissioned in the system, but must go through 
workflow before they can be approved and turned into active projects.  This section of the guide will show 
you the process for creating a Project Request, and submitting it for approval. 

Steps 

1. In the Main Menu on the left, click on the Portfolio Module. 
2. In the window that appears click on Project Requests.  

      
Portfolio > Records > Project Requests 

3. The Project Requests Manager page opens. 

4. In the toolbar click the “+” button.    

      

Project Request List 

5. An empty Project Requests record opens. The Contact information is auto-populated based 
on your login information.  
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Project Request Contact Info 

6. In the Location drop down select the street address of the building that you would like the 
work to be done in.  This list contains every building on campus and can be searched by 
entering either the street name, number or building number by starting to type in the field. 

Note: The number in parenthesis before the street address is the building code. 
7. The Record # field is a greyed out and is auto-populated by the system.  This number is to 

identity your project request throughout its lifecycle. 
8. In the Category List select the Level of the Project  

Note 1: This field is not visible to individuals in the Requestor Role.  
Note 2: Emergency projects should only be selected by Facilities staff. 
Note 3: Select “Space Request Only” if this is a space change request without any 
construction work. 

9. In the Type field select the type of project based off of who your unit reports to.  
i. Academic (Unit Reports to Provost) 

ii. Non-Academic (Unit Reports to Administration) 
iii. Infrastructure (Building Renewal) 

10. In the Description field type a brief, informative description for the project, ex: “Office paint 
and carpet”. 

11. In the Scope section enter a general overview of the work that you wish to have done, and 
the areas that will be impacted. 

12. In the toolbar click the “Save” button.  
Note: The main view must be filled out and saved for the Required Fields to be editable. 
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Completed Project Request header. 

13. In the header bar at the top of the page click the right-most option Specifications. 
This view opens with the “Required Fields” tab selected. 

 

Specification View Open showing Required Fields 

14. Open the fields for editing and in the Data column enter in the requested information.  
Note 1: If you cannot access these fields, click the “Save” button at the top of the page, 
and that will allow you to edit them.  The record must be saved prior to editing the 
Required Fields tab. 
Note 2: Fields listed below with an asterisk (*) are required, all others are optional. 

 What would be the ideal construction start date* – The date you would like 
construction to begin in an ideal situation. 

 What is your anticipated funding source* – The Funding source you think the 
project will be funded by. 

 What is your anticipated cost object – The Cost Object you think this project will be 
applied to. 

 Is this related to a faculty new hire* – If this is a new faculty hire project click yes, 
otherwise select no. 

 New Employee Number – if this is a new faculty hire project, enter the ID of the 
new hire, otherwise leave blank. 

 What is the requesting unit* – Select your department. 

 Note: Once you submit your Project Request to workflow you cannot change the 
Requesting Unit.  To alter a Project Request’s Requesting Unit, you must first 
Withdraw the Project Request, copy it, change the Requesting Unit, and Resubmit. 



34 | P a g e  
 

 Are you looking for additional space or square feet* – If you are looking to expand 
the size of your space, or additional square footage elsewhere, click yes. 

 If yes, how much additional space are you asking for - If you answered yes to the 
above question, give an estimate of the number of square feet you wish to add, if 
known. 

 Will you require Design Assistance* – Will you need design help with your project?  
Such as assistance from an architect or designer? 

 Do you plan on implementing this Project once it is Approved?* 
o Yes: The request is for a Project that will be approved and implemented 

upon acceptable scope of work and estimate. 
o No: The request is to try and define a scope of work and get an estimate 

for a project that may be pursued at a future date. 
o Maybe: Unsure if Project will be implemented.  Decision to be based on 

amount of estimate. 

 The next four required questions ask if the scope of your request includes any of 
the following  

 Demolition* – Will your project require the removal of walls or redo of ceilings 
or floors? 

 Systems Furniture or Work Stations* – Will you need any new cubicles or work 
stations? 

 Heating, ventilation, AC* - will your project modify any heating, ventilation or 
AC? 
Note: If ceilings are being impacted, click “Yes" 

 Walls to be moved or built* – Will your project require any walls to be either 
moved or created? 
 

15. Click the “Update Records” button at the top of the list of Specification Fields. 

 

Update Records button indicated 

16. Click on the “Scope” tab. 
17. Open the fields for editing and click the check-box next to any types of work that you believe 

your project will require. 
18. Click the Update Records button. 
19. Click the Submit button in the top bar of the page and the Submission window will open. 

 

Submit button  

This window is made of 4 sections 

i. Header – Click the  button to move this Request forward. 
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Click the Cancel button  to go back and alter the request prior to 
submitting. 

ii. Comments – Add any comments you would like to the request here. 
iii. Additional CC – Enter the email addresses, separated by a comma without a space, 

of anyone you would like to notify of the project request submission. 
Note: You do not need to include the Approvers in this list as they are 
automatically notified by the system. 

iv. File Attachment and List – Click the green file bar to add any additional attachments 
to the request, which then appear in the box below. 

 

Submit Window 

20. Click the Submit button to move the request forward. 
21. The Project Request is submitted to Workflow. 

Note: The fields in the Project Request will be locked once the request has been 
submitted. 
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Projects and Companies 

Once a Project Request has been approved it is assigned to a Project Manager to begin the Project Lifecycle. 
projects@BU will store the estimates, budget, designs and documents for all projects. 

Projects 

Updating and Reviewing a Project 

A project should only be created manually if an exception has been made to the Project Request 
workflow.  Usually, these project requests come from University Leadership.   

All other Projects must go through the Project Request Workflow, including emergency maintenance 
projects, to ensure proper approvals have been made. 

Steps 

1. Use the main menu to navigate to Portfolio > Records > Projects.  

 
Portfolio > Records > Projects 

2. The Projects list page opens. 

 
Project List 

3. Select the Project that you wish to update, and double-click on the line in the list.     
4. The Project record opens. 
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Project Record Main View 

5. The Program is the University academic or business unit of the project client.  This also 
controls security access and workflows for the project. 

6. The Project ID field auto-populates and cannot be modified by the user. 
7. The Project Name conforms to a specific standard to make searching and identifying specific 

projects much easier for the whole team. 
The project name consists of several pieces of information separated by dashes:  
i. 6-character number/letter address 

ii. A very brief (three or four words) project description 
iii. Calendar year the construction is expected to start 

 

Properly Formatted Project Name 

8. The Project Status has multiple options 
i. Unassigned – This project has been generated from project request and has not yet 

been assigned to a Project Manager.  
ii. Assigned – This project has a Project Manager assigned. A kickoff meeting with the 

client is required to define the scope.   
iii. Active – This project has a Project Manager assigned. Resources are being utilized. 

Refer to the project phase for more detail on this project status.  
iv. Closed – All work associated with this project has been completed. This project is 

closed in SAP. 
v. Hold – This project had a Project Manager assigned. Due to some circumstance the 

project resources are not performing work. Refer to the notes view for more 
information.  

vi. Canceled – Work associated with the project has concluded. The project was not 
implemented. Any SAP account is closed.  

vii. Duplicate – This project exists as another project; this is a duplicate project and will 
not be used. Refer to the other project.   

viii. Frozen – This project has a Project Manager assigned. This project has been put on 
hold due to a capital funding freeze.  
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Note: This status was used during the Covid-19 crisis to indicate projects on hold 
due to Covid-19 budget concerns. 

9. The Project Type and Category fields help structure projects@BU views and reports so that 
similar Projects can be grouped together. 

10. Project Manager holds the name of the Project Manager for sorting purposes. 
11. The Placeholder Budget field holds the estimated budget of the project prior to any Scoping, 

Planning or Design work having been completed, the actual budget of the project is entered 
in the Budget module. 

12. Target Start, is the targeted start date of work on the project. 
13. Target Finish, is the targeted completion date of the project. 
14. The Scope field holds the starting scope of the project.  This field remains the same 

throughout the project lifecycle. Current Scope is documented under the Specifications tab 
in the Current Scope tab. 

15. The Project Phase dropdown shows the current phase that the project is in. 

16. Once any changes have been made in the toolbar click the “Save” button.  

 

Updated Projects Record 

17. Under the “SAP Data” section is the Project Account code for the project. 
Note: This is updated automatically after the Budget Request is successfully approved 
and integrated into SAP.  

 

Project Account field 

 
18. The Capital Freeze Exception field indicates if this project was noted as an exception during 

the 2020 – 2021 COVID-19 Capital Freeze. 
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Capital Freeze Exception 

 
19. Click on Specifications at the top of the page to view the Project Specification fields.  

To access the different Specification tabs, click on the tab names to the left. 

 

Specifications Tab with sub-sections shown 

 
These values can be changed by anyone with write access to Projects (Project Managers 
and Executives) by highlighting the line or lines that you want to change and clicking the 

Edit button.  
Note: Core Team, Internal Stakeholders, and External Stakeholders tabs do not control 
access to the project.  They are used for reporting and as a quick reference.  Access to 
the Project is granted through the “Users” tab. 

20. The Core Team tab tracks who are in the main roles of the Project Team.  
Note: If the Project Manager field in this tab is not blank, any Budget Requests 
submitted will be rejected by SAP, slowing down the approval process. 

21. Internal Stakeholders are BU employees who are outside the core team but still involved 
with the project. (For example: BUPD, EH&S, and IS&T) 

22. External Stakeholders are people or organizations outside of BU that are involved with the 
project. (For example: Architect, General Contractor) 

23. The Project Level tab holds the level of the project. 
24. The Current Scope tab holds:  

i. If scope changes, an updated scope of the project can be entered in the Current 
Scope field to be compared to the Original Scope. 

ii. The checkmark on the SPACE Report row specifies if a project is to be included on 
the SPACE report. 

iii. The size of the Project: 

 Project Size Net/Gross – The Total Size of the Project in both Net and 
Gross Square Feet.  In most cases, only Net square footage is needed. 

 LEED Square Footage Net/Gross – The LEED size of the Project in both 
Net and Gross Square Footage. 

iv. The Special Schedule drop down indicates if a project is specifically scheduled to 
occur during: 

 Intercession – During the school break from the end of December 
through January 

 Summer – During the school break from the end of June to August. 

 N/A – Select this option for neither. 
v. Once a project is complete use the Placed in Service Date to record the point in time 

when a property or long-term asset is first placed in use for the purpose of 
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accounting, primarily to calculate depreciation or grant a tax credit. The date the 
asset is placed in service marks the beginning of the depreciation period. 

vi. The Capital Project Status drop down indicates if a project is: 

 Capital 

 Non-Capital 
Note: This determination is usually made with the assistance of Budget Planning 
& Business Affairs. 

vii. Once a Project has reached Closed Status the Project Close Reason indicates if it was 
closed due to: 

1. Project Complete – The work has been done and the accounts are closed. 
2. Client not Proceeding – Client decided not to proceed with the project.  

Note: This option is in addition to the “Canceled” status, since it 
indicates that the Project was closed due to the client specifically. 

viii. The next four (4) selections are grouped as a series and apply directly to the LEED 
status of a Project.  

1. LEED Project – This field indicates if we are seeking LEED status for the 
project. 

 Yes 

 No 
Note: If this is set to “No” then none of the following fields are 
required. 

2. LEED Submission Status – This field tracks where the project is in the LEED 
submission process. 

 Not Submitted – Project has not yet been submitted for LEED 
Certification, but will be. 

 Submitted – Project has been submitted for LEED Certification 

 Not Achieved – Project has been reviewed and not given a LEED 
Certification. 

 Achieved – Project has been reviewed and given a LEED 
Certification. 

Note: Once a project has been submitted for LEED, the rating field is 
required to show what rating the project is following. 
 

3. LEED Rating System – This field indicates the rating system being used for 
the project.  The options are: 

 V4 – BD&C 

 V4 – Homes 

 V4 – ID&C 

 V4 – O&M  

 V4.1 – BD&C 

 V4.1 – Homes 

 V4.1 – ID&C 

 V4.1 – O&M  
Note: This field is required if LEED Submission Status is “Submitted.” 

4.      LEED Certification (Sought) – This field indicates the certification 
level that we are seeking for the project.  

 LEED Certified 

 LEED Silver 

 LEED Gold 

 LEED Platinum 
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5.      LEED Certification (Achieved) – This field indicates the certification 

level that a project has achieved. The available options are: 

 LEED Certified 

 LEED Silver 

 LEED Gold 

 LEED Platinum 
Note: This field is not required if the Submission Status is “Not 
Achieved.” 

25. The Users tab gives Project Managers the ability to assign a GC, Sub-Contractor, Architect, 
and Project Executive (if applicable) to the workflow approval roles for a Project. 

WARNING: If these roles are not assigned properly the workflows will not route to the 
proper approvers, and this can lead to delays in the approval process. 
Note 1: By default, BU users can only view those projects that are assigned to their 
Academic or Business unit. 
Note 2: To request a user to be added to projects@BU, first add them as a contact to 
their Company (see Company Section), and then submit a ticket to ithelp@bu.edu for the 
User to be granted access to projects@BU. 

26. The Notes tab allows permissioned users to add project notes.  These can be ordered and 
filtered by Creator, Creation Date, Description or Edit Date. 

Note: See the “Creating a Note” section under projects@BU Basics for instructions on 
adding a note to Record in projects@BU. 

27. The Attachments tab allows you to attach documents to a project.   
Note: See the “Using the Document Manager and Attaching Files to Records” section 
under projects@BU Basics for instructions on how to load documents into projects@BU 
and then link them to a record. 

Adding Team members to the Project and Workflows 

All Projects in projects@BU have several roles that must be assigned prior to processing Commitment and 
Change Orders.  The roles correspond to team members on projects including the Project Manager, 
Architect, Project Executive, and the General Contractor.   

 

Users tab shown with list of Project users on the left (a) and Workflow Roles (b) on the right. 

 

The following image key shows how to read the icons next to the users’ names which show how they have 
or have not been granted access to the Project. 
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User access icon key 

Adding a User to a projects@BU Project 

1. With a Projects record open click on the Users tab.  
2. In the “Project Access” section of the window, click the checkbox next to “Only display 

users with Access”. 
The left-hand side of this tab shows all users in projects@BU as well as the list, by role, 
of all users who have access to this Project.  The right-hand side of the tab shows the 
Workflow roles for the Project as well as the Users that have been assigned to those 
roles. 
Warning: Prior to entering any Engineering Form record into workflow through 
projects@BU you must fill out the appropriate roles for the workflow to route as 
intended, otherwise your document will be rejected and will need to be re-submitted. 

 

    

Project Access section with “Only display users with access” indicated. 

 
3. Validate that the user you wish to add does not already have access to the project by: 

i. Click the arrow button next to the role of the user 
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Project Access List highlighted with arrow button indicated. 

Note: If you do not know the role of the user, contact the System Administrator through 
ithelp@bu.edu, and they can tell you. 

ii. Check to see if the user’s name is present in that list. If name is present, then move 
to “Configuring Project level Workflow Roles for a projects@BU Project.” If not 
proceed to step 4. 

Note: By default, all Project Managers have access to all Projects, and Sponsors 
have access to all Projects in their department(s). 

4. Open the drop down on the user’s role in the full user list on the left. 
5. Drag the user from the full user list and drop it on the name of the project on the 

project list to grant them access to the project. 

 

Granting a User access to the Project. 

 

Adding users to project workflows 

 
In the Project window click on the Users tab. 
Click the “View Unlocked Roles Only” checkbox to limit the list to the roles you can assign for the project.  
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“View Unlocked Roles Only” 

 
Locate the Workflow Roles section on the right-hand side. 

 

Workflow Roles section highlighted 

 
In the “Users” section locate the name of the user you wish to add to a role. 

Note: This list is alphabetical by First Name and only contains users who have access to the 
Project. To put someone in a workflow role, they must first be granted access to the project 
in the step above. 
    

In the “Workflow Roles” section, locate the role you wish to add the user to. 

 

Workflow roles list highlighted with both “locked”(a) and “unlocked”(b) roles indicated. 

 
Note 2:  Many roles are locked at the system level because these roles are system wide.  The 
roles that can be changed by the Project Manger are those that vary by project.  These are: 

 Planner/Architect 

 Project Director 

 Project Executive 

 Project Manager 
Click-and-drag the name of the Project User you wish to add to a specific role from the “Workflow Roles” user list, 
to the role list. 
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Dragging a User to the appropriate role. 

 
Repeat steps 3 – 6 for each Project Level Role. 

 
 

Companies 

Companies in projects@BU are created by the System Administrators and must first be verified as 
Suppliers through Boston University’s Souring & Procurement department as well as added to SAP.  Once 
a company is created, any Project Manager can add Contacts to that Company, and request that those 
Contacts be created as Users by emailing ithelp@bu.edu. 

General Navigation 

1. Use the menu to navigate to Portfolio/Records/Companies. 

 

Portfolio -> Records -> Companies 

2. Click the grey Record # link to access the Company record. 
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Company List 

 
3. In the Record Main view you will see several fields. 

i. Company ID – This is the auto-generated record number for the Company. 
ii. Name – The full name of the Company, and the primary way you will search for the 

company in any lists. 
iii. Type – The type of work that the Company performs, for example Architect, 

Contractor, Life Safety 
iv. Abbreviation – A shortened version of the Company’s name, this can be used in 

either Reports or Forms in projects@BU to save space on longer company names. 
v. Reference – This field indicates the Company’s Bidding Status: 

1. Registered Vendor – This company has gone through BU’s vendor approval 
process, and is a registered company. 

2. Bidding Company Only – This company has not gone through BU’s vendor 
approval process, and will be required to go through that process prior to 
starting work at BU. 

vi. Account # - The Company’s Account number in the Procurement system. 
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Company Main View 

4. Next to the main Company information you will also see the Primary Address. This is the 
main address of the company (see #6 right below). 

5. Specifications – This view has several tabs that define any Specialties, Scope Areas, 
Professional Services, or Certifications that the Company has, as well as their Labor Type 
(Union vs non-Union). 

6. Addresses – This is the address for the Company as provided by either their Vendor 
Registration Form (for Approved Companies) or directly by the vendor (for Unapproved 
Companies).  If multiple, one of these addresses is selected as Primary and is the address 
displayed on the Details tab. 

Note: The ID column at the left of the address fields is very important as it is what 
identifies the mailing address for each Company Contact in projects@BU. 

 

Completed Address Record in projects@BU, with Primary Address Checked 

7. Departments – Though largely unused, if there is specific contact information for a 
department within a Company, that information is listed here. 

8. Contacts – These are the names, phone numbers, and email addresses of BU’s contacts at 
the company. 

Note: Any individual who needs to be a user in projects@BU must first be set up as a 
contact.  Once they are a contact in projects@BU a ticked must be submitted to the 
helpdesk (ithelp@bu.edu), for them to become a user 
Note 2: For external vendors the ID field in the contacts list will be the user ID. Please use 
their email address for this field.  

Creating a Contact 

Follow these steps to create a new Contact for a Company in projects@BU. 

Note: A Contact must be trained and be set up as a User to access the system. After creating the 
contact record, please send an email to ithelp@bu.edu and request that a Contact be trained and 
granted access to the system. 

Use the menu to navigate to Portfolio/Records/Companies 
9. In the list view, in the whit box below the Company column header, type in the name of the 

Company you wish to add a Contact to and hit Enter. 
10. Click on the grey Record # link to enter the Company Record. 
11. In the list of tabs in the top of the page click “Contacts.” 
12. Click the “Add” button at the top of the list. 
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Contacts View with Add Button Indicated 

13. A new line will be created with a yellow background to distinguish it from the previously 
existing contacts. 

14. In the ID field enter the email address of the Contact 
15. Enter the First Name and Last Name in the appropriate fields. 
16. Select an Address ID from the drop-down list that corresponds with the correct Address for 

the Contact.   

 

Newly created Contact with yellow background shown. 

17. Click the “Save” button at the top of the list to add the Contact to the Company.  

 

Show the correct save button to be used to save contacts. 
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Project Schedule and Gantt Chart Overview 

Schedules 

projects@BU scheduling allows you to track project schedules, milestones, and critical paths appropriate to the 
needs of the project. 

 

Typical Milestone Schedule in projects@BU 

Reading the Gantt Chart 

The visual format of an element in the projects@BU Gantt chart signifies the type and/or status of the 
element. It is important to understand what each format means to correctly interpret the schedule. 

Task Bars 

  - A task not on the critical path which is 0% complete 

  - A task not on the critical path which is 30% complete 

  - A task which is 100% complete 

  - A task on the critical path which is 0% complete 

 - A task on the critical path which is 80% complete 

Dependency Connectors 

This is a Start-To-Start(SS) dependency: 

The arrowhead indicates that it is a successor for Task 1 and a predecessor for Task 2 
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This is a Start-To-Finish(SF) dependency: 

The arrowhead indicates that it is a successor for Task 1 and a predecessor for Task 2 

 

This is a Finish-To-Start(FS) dependency: 

The arrowhead indicates that it is a successor for Task 1 and a predecessor for Task 2 

 

This is a Finish-To-Finish(FF) dependency: 

The arrowhead indicates that it is a successor for Task 1 and a predecessor for Task 2 

 

Red dependency connectors indicate that the schedule needs to be recalculated: 

 

 

The dashed line segment of a connector indicates a lag, in this example a lag of +2 days: 

 

The dashed line segment of a connector indicates a lag, in this example the lag is -2 days:  

 

Constraints 

This example shows a task with no constraints: 

 



51 | P a g e  
 

Constraint - None 

The following screen shots show various constraints and their constraint dates. Notice how each 
constraint is displayed in the Gantt chart: 

 

Constraint - Finish No Later Than 

 

Constraint - Must Finish On 

 

Constraint - Must Start On 

 

Constraint - Start No Earlier Than 

Copying a Template Schedule and Updating Tasks  

Creating a Project Schedule from a Template allows for enhanced client communication through both 
access to a shared schedule and enhanced Project reporting.  

In this lesson, you will copy a template schedule and then learn how to modify scheduled durations. 
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Steps 

1. Use the menu to navigate to Scheduling / Schedules. 

 

Scheduling Schedules 

2. Click the “+” button. 

 

Schedule List with + button indicated 

3. In the Project field select your project. 
4. In the Description field enter “Project Milestone Schedule.” 
5. In the Type field select “Overall Project.”  
6. In the Calendar field select “001 – Standard.”  

7. Click the “Save”  button to save your settings prior to loading the template. 
Note: This step is essential.  Loading a template onto an unsaved schedule will overwrite 
both the Project Name and Description fields with the name and description from the 
template schedule. 

8. In the Header, click the arrow next to the plus “+” icon, and click “Copy from Schedule” 

 
 

9. The Select a Schedule dialog opens. 

 
10. Select the project number hyperlink of the project you want to copy your schedule from.  

This can be either a template (Indicated as Level 1-2, Level 3, Level 4, Level 5 Template, or 
Facilities Template), or any other schedule in the system. 

 
Project number hyperlink indicated 
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projects@BU (PMWeb) will load the selected schedule into the schedule window below 
with all tasks having the base start and end date populated matching the template you 
chose.  

 
11. In the schedule controls bar enter the start date of the project by clicking on the calendar 

icon and selecting the day in the calendar that opens. 

 

Start and Date Indicated 

12. Click the “Save” button on the schedule controls bar to update the schedule with your new 
start date. 

 

Save Button 

13. To update the duration of a specific task, click on the ID of that task in the list, and the 
“Details” tab below will display details for it. Alternatively you can select each task from the 
“Select Task” dropdown in the details tab below the schedule. 

 
ID and Task Details Shown 

a. The Start Date updates automatically based on the end date of the previous task. 
b. On the “Current” line, update the Duration Days, or update the Start/End Date field. 

Note: If you need to back date (set a date prior to the creation date of the schedule   
template), then you need to enter the start and finish dates of the task in the 
“Actual” date fields, otherwise the system will automatically adjust tasks back to 
the templated start date. 

c. Click the “Save Task”   button in the Details tab to save your changes.  
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Date fields and Save Task Indicated. 

d. Click the Check Mark  to update the dependent tasks on the schedule. 
14. Repeat Steps 13 for each task as needed. 
15. Click the Save button at the top of the Schedule to save all your updates.  

 

Save button on schedule 
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Estimates and Budgets 

Estimates 

The Estimates record gives Project Managers a tool to either create a proposed budget, or to request pre-
budgeting funds, such as site surveys or Architecture and Engineering.  A Budget Request can be generated from 
an individual line item or the entire Estimate. 

The Budget Request is then submitted to Workflow for approvals. Once the submission is approved the requested 
lines become the original budget. 

Note: Estimates are seen only by the Project Manager and Project Director Roles in projects@BU, they are where 
PMs can experiment with various project budgets before requesting their final budget.  While it is possible to create 
a Budget Request directly without going through the Estimate Process, the Procurement and Bidding Process is 
based off of the Estimate Record, not the Budget Request. 

Note 2: The process for moving money from one cost code/line in a budget to another, for instance moving money 
out of contingency into a line that requires more for a commitment, is through a Zero-Dollar Budget Request. This 
process is detailed at the end of this section. 

Creating an Estimate 

Follow these steps to create an Estimate in projects@BU. 

Creating the Header 

1. Use the main menu to navigate to Planning/Portfolio Planning/Estimates.  

 
Planning / Portfolio Planning / Estimates 

2. The Estimates page opens. 

 
Estimate List 
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3. In the toolbar at the top of the list click the  button .   
4. A blank Estimate record opens. 
5. In the Project field select the Project you wish to create an estimate for. 
6. In the Description field describe the Estimate. 
7. In the Estimate Unit of Measure select the Unit of Measure used for the Estimate. 
8. In Category drop-down select the basis of the estimate, for example “Rough Order 

of Magnitude (WAG).” 
9. In the toolbar click the “Save” button.  

Note: Once the Estimate is saved, the estimate details will now be displayed. 

 
Completed Estimate screen with Details indicated. 

 

Adding Template Items to an Estimate. 

While it is possible to create an Estimate by manually adding Items, projects@BU has two 
templates, called Assemblies, which have a collection of Items commonly found in either a Level 
1-2 or 3-5 Project.  To add an Assembly to the Estimate, follow these steps. 

1. In the toolbar of the Estimate Details click the “Add Assembly” button.  

 

Add Assembly button indicated 

The Assemblies window opens. 
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Assemblies window 

In the Select Assembly drop-down select the “Level 1-2 Estimate Template” for Level 1 
or 2 Projects, or the “Level 3-5 Estimate Template” for Levels 3 to 5 Projects. 
Note: While these Assemblies contain a collection of items, it is just a starting list. Once 
an Assembly has been added to an Estimate record, it can be further customized by 
adding or removing Items. 

 
Assembly Options shown 

In the top left of the window, click the “Save and Exit” button.  
The list of items now appears in the Estimate. 

 

Manually Adding Items to an Estimate 

The Estimate is made up of Items and can either be approved as a whole, or on a per-item basis.  
projects@BU has an extensive catalog of Items representing the CSI Cost Codes.  The instructions 
below show how to add those line items to an Estimate.  

1. In the toolbar of the Details table click the “Add Items” button.   
2. The Items dialog box opens. 

 

Items window shown with Items Catalog indicated 
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3. Expanding the Items Catalog folder shows the general categories that Items are broken 
into by the type of Costs they represent, either Construction, Owner Controlled or 
Contingency. 
Note: For projects created previous to 9/2019 you will need to use the “Old” set of Cost 
Codes. 

 
4. Expanding, for example, the Owner Controlled Costs folder by clicking the arrow next to 

it, shows the three phases that Cost Codes are separated into. 
Note: For single-phase Projects, pick the “Phase 1” folder. 

 
5. The next set of sub-folders contain all the Owner Controlled Cost Groups, including Design 

Fees, FF&E, Security, and Insurance. 

  

6. Expanding, for example, the sub-folder 03 Concrete holds Concrete-related cost 
centers. 

 

Expanding the 03 Concrete Folder 

7. Click the appropriate cost item(s) and drag them from the Catalog on the left to the 
table on the right. 
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Drag the Cost Code(s) you have selected on the left to the table on the right. 

    

  
The Cost code(s) now appear in the table. 

8. Click the “Save and Exit” button in the Items dialog box.   
9. The Items dialog closes and the new items appear in the Details section on the 

Estimate. 
Note: If the Cost Codes do not auto populate, contact the PMWeb System Admin as 
this project may be associated with the older Cost Code set. 

Adding Companies, Bid Categories and Costs to the Estimate 

1. Select the items in your Estimate and click the “Edit” button. 
2. In the Bid Category field select the type of bid for each line in the Estimate. 

Note: This field is how projects@BU separates your Estimate lines into individual 
Procurement (bidding) records. 

 
Procurement Types 
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3.  Type the Quantity of services or materials you need for the Estimate. 
4. Type the Unit Cost of the Service or material 

Note: When you enter a Unit Cost and Quantity the system generates an Ext. Cost, 
for instance a Quantity of 7 times a Unit Cost of $70.00, generates an Ext. Cost of 
$490.00. 

5. In the toolbar of the Details table click the “Update Records” button. 

 

Figure 1 – Estimate Record with all required Fields filled out 

Submitting all or Part of an Estimate for Approval Workflow 

Once Items have been added to an Estimate either the entire Estimate or specific Items can be 
used to generate a Budget Request record, which is then submitted to Workflow for Approval. 
The following steps show you how to generate a Budget Request. 

Note: Only Items with associated Cost Codes can be submitted to Workflow.  If you do not have 
Cost Codes associated with the Items in your Estimate, you need to contact the PMWeb system 
admin to resolve this issue prior to generating a budget request.  

1. Change the status of the Estimate in the header from “Draft” to “Approved”, and then Save 
the Estimate.   

 
 

Status dropdown location shown. 
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2. In the toolbar of the Estimate header click on the down-arrow next to the 

“Generate” button  to bring up the options. Select the “Generate Budget 
Requests” option. 

 
 

Generate menu opened with Generate Budget Requests highlighted. 

3. The Budget Request window will open. 

 
Budget Request pop-up window. 

4. If you wish to submit all of you Estimate to Workflow, then click the “Generate”  

button  at the top of the list to submit the whole Estimate to Workflow. 
5.  If you wish to submit individual lines to workflow, either unclick the check-boxes 

next to the lines you do not wish to submit, or click the check-box at the top of the 
list to unclick all the lines, and then click the check boxes next to the lines you wish 

to submit only, and then click Generate .   
Note: You will know that the lines were properly submitted when the green “The 
action has been successfully completed” message appears. 

6. Close the window by clicking the “X” in the upper-right corner. 

Budget Requests 

Budget Requests can either be directly generated from an Estimate record, or in the case of a Budget 
Adjustment, created directly from the record menu.  The steps below show you how to complete both 
processes. 

Budget Requests – Submitting to Workflow 

1. Once you have generated your Budget Request use the menu to navigate to Cost 
Management/Budgets/Budget Requests. 
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Cost Management / Budgets / Budget Requests 

2. In the list that appears, open the Budget Request that you just created. 
3. In the Type* dropdown select the type of Budget Request that you are submitting. 

 

Type selection 

 Planning Funding Request – A request to do initial planning – before any 
kind of design can begin. 

 Cost Model – A space has been identified, the square footage of space to 
be affected is known, and the kind of work (tenant build out, wet lab, dry 
lab) Numbers are assigned based on benchmarking. 

 Schematic Design – Pricing based on Schematic Design Documents – Soft 
Costs are not well defined. Contingency could be 15-25% 

 Design Development – Pricing based on Design Development Documents – 
Soft Costs starting to be identified and priced; but still most not well 
defined. Contingency could be 10-20% 

 Construction Documents – Pricing based on Construction Documents; Soft 
costs well defined and majority of hard numbers in hand. Contingency – 5-
15% 

 Budget Adjustment - Post-Commitment Budget Adjustments only, do not 
select this option for a non-adjustment Budget change. 

4. Click the “Save” button at the top of the record. 
5. From here you have two paths, you can either Quick submit, or go through the Workflow 

View. 
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Quick Submit 
1. Click the Submit button in the top bar of the page and the Submission window 

will open. 

 

Submit button  

2. This window is made of 4 sections 

 Header – Click the Submit  button to move this Request forward. 
   Click the Cancel button  to go back and alter the request 
prior to submitting. 

 Comments – Add any comments you would like to the request here. 

 Additional CC – Enter the email addresses, separated by a comma 
without a space, of anyone you would like to notify of the project 
request submission. 

 Note: You do not need to include the Approvers in this list as they are 
automatically notified by the system. 

 File Attachment and List – Click the green file bar to add any additional 
attachments to the request, which then appear in the box below. 

  

Submit Window 

3. Click the Submit button to move the request forward. 
Workflow View 

Click the “Workflow” view at the top right of the record. 

 

Workflow View 

Click the “Submit” button. 
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Workflow view with “Submit” button 

In the “Comments” section type any Comments or notes that you would like to 
provide to the next Approver in the Workflow. 
Note: You can add one or more email addresses to the “CC” to copy on the Budget 
Request by manually typing in their emails, with a semi-colon (;) between the 
addresses. 

 
 

Comments and CC’ed Addresses Added to Workflow Tab 

Click the “Save” button to submit the Request to Workflow. 

 
Workflow tab after pressing “Submit” button with “Save” button now showing. 

Note: Once the workflow has been submitted and saved to Workflow it cannot be 
modified unless it is sent back for revision by one of the Approvers in the Workflow. 
Note: You can check the status of the workflow request by viewing the status list in the 
“Business Process” section of the Workflow tab. 
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Budget Adjustment Process 

Unlike Project Budget Requests, Budget Adjustments do not need to start with an Estimate 
record.  Follow these steps to submit a Budget Adjustment to transfer money in an approved 
budget from one line item to another, ex: From contingency to a construction line item. 

1. Navigate to Cost Management > Budgets > Budget Requests 

 
Cost Management > Budgets > Budget Requests 

Click the “+”  button in the toolbar at the top of the list. 
Select your Project from the drop-down. 
In the Type field, select “Budget Adjustment” 
Enter in a Description that you will recognize. 
Leave the Estimate field blank. 
Click the “Save” button at the top of the record. 

 
Completed Budget Adjustment Header with fields shown. 

In the toolbar on the Details tab, click the “+ Add Cost Codes” button. 
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Details toolbar with “+ Add Cost Codes” button indicated. 

In the window that appears, navigate through the left-hand folder tree to the Cost 
Code you need to move money to, and then drag it to the right-hand list. 

 
Moving cost codes from the tree to the list. 

Repeat step 9 for any further codes you need to transfer money to. 
In the window that appears, navigate through the left-hand folder tree to the Cost 
Code you need to move money from, and then drag it to the right-hand list. 
Click the “Save and Close” link at the bottom of the window. 
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“Save and Close” link indicated. 

Open all chosen lines for editing. 
Note: See “Selecting and Editing Fields” in projects@BU Basics for how to edit these 
lines. 
Enter a positive (+) dollar value in the Unit Cost field for the lines you are moving 
money to. 
Enter a negative (-) dollar value in the Unit Cost field for the lines you are moving 
money from. 

 
Moving from (-) Contingency to Ceilings. 

2. Click the “Update Records” button.  
3. Click the “Workflow” tab. 
4. Click the “Submit” button. 
5. In the “Comments” section type any Comments or notes that you would like to 

provide to the next Approver in the Workflow. 
6. Click the “Save” button to submit the Request to Workflow. 

Note: Once the Budget Request has been submitted to Workflow it cannot be 
modified unless it is sent back for revision by one of the Approvers in the Workflow.  
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You can also “Withdraw” the request from workflow, but this close it and it will need 
to be re-created. 
Note: You can check the status of the Request by viewing the list in the “Business 
Process” section in the Workflow tab. 

 
 

Approving a Budget Request and Adding the Cost Center 

After a Budget Request has been submitted it goes through several approval steps, the first of which is 
completed by the Departmental Approver who adds the appropriate cost center and then Approves the 
Budget Request to be passed on to the Financial Administrator.  The steps below detail this process. 

1. Click on the “Budget Request” item in your Workflow Inbox. 

 

Workflow inbox with Budget Request Indicated 

Click on the Main view to review the amount of the Budget Request. 

Main View 

In the header of the Budget Request, click on the drop-down next to “Responsible 
Cost Center” and select the appropriate Cost Center for this project. 
Note 1: If your project is going to be funded by the University Provost’s office, please 
select “9999999999 – Centrally Funded” as your Cost Center. (see below) 

 

 

Centrally Funded Project 
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Note 2: If you do not see a Cost Center that you believe you should have access to, 
contact the PMWeb Admin by emailing ITHelp@bu.edu to have your access 
validated and granted. 

2. Click the “Save” button at the top of the record to save your entry from step 3. 

 

Save button Indicated 

3. Click the Workflow view to show the workflow options. 

 

“Workflow (Step 2 of 6)” tab Indicated 

 

4. Approve the Budget Request by clicking the circle next to “Approve Budget 
Request” and then click the “Take Action” button at the bottom of the list.  

 

Approve Option and Save button Indicated 

 

Reviewing a Budget Request and Updating Centrally Funded Cost Objects 

Once the Budget Request reaches the “Financial Approver” stage, Business Affairs will 
receive a notification email from projects@BU to review the Budget Request. 
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1. Select the Budget Request from the list of notifications. (See step 1 above) 

2. If the Budget Request has “9999999999 – Centrally Funded” as the Responsible 
Cost Center, go to step 9, if not proceed to step 10. 

3. Review the Budget Request with the Provost’s Office to determine if the project will 
be funded by that office. 

i. If the Project will be funded by the Provost’s Office, select the “Office of the 
Provost” Cost Center from the drop down list, and then click “Save” at the 
top.  On the Workflow tab, select “Approve Budget Request” from the list of 
workflow actions. 

 

Centrally funded Cost Center Selected 

ii. If the Project will not be funded by the Provost’s Office, on the Workflow 
tab select “Return Request” from the list of workflow actions to send the 
request back to the Departmental Approver as well as adding a note saying 
they must select a Cost Center they have access to.  

4. Validate the selected Cost Center for this Project. 
i. If the Cost Center is appropriate, on the Workflow tab select “Approve 

Budget Request” from the list of workflow actions 
ii. If the Cost Center is not appropriate, on the Workflow tab select “Return 

Request” from the list of workflow actions to send the request back to the 
Departmental Approver as well as adding a note saying they must select an 
appropriate Cost Center. 

5. Click the Save button on the Workflow tab. 
 

Note: Once the Budget Request has been fully approved, it will be automatically 
submitted to SAP at 8pm that night, and an “Approve: Create Internal Order 
Request” will appear in your SAP worklist. 

 
6. After the Project Account has been created in SAP, the account number will be 

pulled from SAP into projects@BU at 9pm the next night, and the Account Number 
will be automatically populated to the Project record. 

Work Order (FSR) Entry 

Work Orders associated with projects are still being processed through CAMMS.  Follow the screenshot 
below to find the PM Web Work Order Entry link. 
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Cost Worksheets 

Once a Budget Request has been approved, you can view the Budget in the Cost Worksheets section of 
projects@BU.  Currently this allows you to view all the Budgeted Costs for the Project, as well as the origin 
of those Costs within the system.   

Once Phase 3 of the Implementation Project has been completed you will also be able to use Cost 
Worksheets to compare the Current Budget vs any Change Orders or Costs booked against the Budget as 
they are submitted by the vendors. 

Running a Cost Worksheet 

1. Open the Cost Worksheet list by navigating to Cost Management/Budgets/Cost Worksheets. 

 
Cost Management > Budgets > Cost Worksheets 

2. In the Project Dropdown select the name of your Project. 
3. In the Worksheet Dropdown select the type of Cost Worksheet that you wish to view. 

Currently only “Level 5 Worksheet” is available but more may be added at a later date. 
4. The Budget Worksheet is divided into several standard Columns, these are: 

 Cost Code – The Cost Code that ties to that line item. 

 Budget Description – The Description of Cost Code. 

 Original Budget (A) – The Approved Budget for that Cost Code. 
Note: If you have any Unapproved Budget Requests or Estimates they will not 
appear here until they have been approved through Workflow. 

 Pending Budget Changes (B)– Any Change Orders that are currently being 
processed in workflow for this Budget Line. 
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 Approved Budget Changes (C) – Any Change Orders that have been approved for 
this Budget Line. 

 Current Budget (D = A + C) – The Approved Original Budget Plus the Current Budget 

 Anticipated Budget (E = B + D) – The Current Budget plus the Pending Budget 
Changes 

 Original Commitments (F) – Commitments that have been approved. 

 Pending Commitment Changes (G) – Commitment records that are currently being 
processed through Workflow. 

 Approved Commitment Changes (H) – Commitment CO’s that have been Approved 
through Workflow. 

 Current Commitments (I = F + H) – Original Commitments Plus Approved 
Commitment Changes 

 Anticipated Commitments (J = G + I) – Pending Commitment Changes plus Current 
Commitments. 

 Pending Exposure (K) 

 Approved Exposure (L) 

 Total Exposure (M = K + L) 

 Forecasts – Pending – The total amount from the Forecasts record. 

 Budget Remaining (N = D - I) – Current Budget minus Current Commitments.  

5. Any line on the Worksheet can be expanded by clicking on either the arrow icon to the left of 
the Cost Codes or the grey values on the line. 

6. The expanded view show the source of the value that you clicked on, for now this is just the 
Budget, but in the future both Commitments and Change Orders will be linked here. 

 

Typical Cost Worksheet 
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Bidding and Procurement 

The bidding process in projects@BU occurs in the Planning module where the Bid Package record is created as 
well as holding the Online Bidding records.  Invitations to bid are also sent out from the Bid Package which directs 
the firms to log into the system to submit their bids.  When that is complete, the Project Manager uses the Bid 
Packages record again to level the bids and select the winning bidder. 

Note: Architects and OPMs are not bid through projects@BU, they are bid out directly through Sourcing & 
Procurement, as the selected Architect/OPM has full access to the bidding record and would be able to see their 
competitor’s bids. 

Warning: While companies who are bidding on Projects do not have to be authorized vendors at Boston 
University, they must be created as Companies, Contacts, and Users in projects@BU.  If a vendor is not available 
for selection in the system, contact the projects@BU System Administrator through ithelp@bu.edu and they can 
set up the Company, and their contact, in the system as a “bidding-only” Company, and provide the contact with 
the access they will need to respond to the bid. 

Note: If a non-authorized Company is selected as the winner of the bid, they will need to go through Sourcing & 
Procurement’s authorization process. Winning a bid through projects@BU does not guarantee that they will be 
authorized by Sourcing & Procurement. 

 Pre-Bid 
= 

While you do not have to start your bidding process in the module, it is recommended if you are bidding 
out multiple types of work, or would like to send different sets of Cost Codes to different companies.  The 
Pre-Bid module allows you to create one bid package, and then divide it up amongst your bidders by type 
of work being performed. 

Creating a Pre-Bid Record 

1. Navigate to Planning > Procurement > Pre-Bid. 

 
Planning > Procurement > Pre-Bid 

2. At the top of the list click the “+”  button. 
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Pre-Bid list. 

3. In the Project* field select the name of the Project you are creating the Pre-Bid for. 
4. In the Description field, type a name for the Pre-Bid that will help you identify this record. 
5. Bid Category is a drop-down list that helps with sorting of the records, the options are. 

 Construction 

 Consultant Services 

 Design 

 Direct Trade 

 FF&E 
6. In the Solicited By drop-down list select “Boston University” as the source of the Bid 

Package. 

 
Solicited By List Opened & BU selected 

7. In the Project Manager list select your name. 
8. Enter the date and time that Bids must be entered into the Bids Due fields 

Note: You cannot enter these until after you have completed the remainder of the process.  If 
you do not want to start the bidding at this time, then leave these fields blank. 

   
 

Bids Due Date & Time 

9. Select the Anticipated Agreement type from the list in that drop-down field, the types are: 

 BU AIA 

 Master Service Agreement 

 BU Consulting Agreement 

 Standard PO Terms 

 Purchase Order 

 Subcontract 
10. The Procurement drop-down list will hold links to any Procurement records linked to this 

Pre-Bid. 
11. Click the “Save” button at the top of the page. 

Note: The Options section is locked to just the System Administrator, if you wish to change 
these options, please submit a Ticket through @ITHelp, as some options cannot be modified 
due to procurement policies at BU. 

 
Completed header 

12. The Bidder Matrix view is where you select the bidders you will be sending the Bid Package 
to. 
a) Click the “+ Add Bidders” 
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Buttons above Bidder Matrix with Add Bidders indicated 

b) In the window that opens click the box next to the bidders you wish to add to this Pre-
Bid. 
Note: This window has two different tabs, Companies/Contacts and Distribution Lists.  
Companies/Contacts can be selected individually while Distribution Lists must be 
configured in the Distribution Lists section of projects@BU. The Select 
Companies/Contacts window will open. 

 
“Select Companies/Contacts” window. 

c) Click the Checkbox to the left of the bidders that you wish to add to the bid.   
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d) After you have selected the bidders, click the “Save and Close” button. 

 
Note: While BU requires that a minimum of three (3) bids be received for each project, not 
all bidders will accept the bid. It is recommended you send out more than the required 
number of bids. 

     
Completed Bidder Matrix (with fields indicated) 
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13. Click the Bid Items view to add the Items from the Estimate to the Pre-Bid record. 
a) Click “+ Add Estimate Items” 

 
Bid Items view and Add Items Indicated. 

b) In the window that opens select the Estimate Items you wish to add to this Pre-Bid. 
Note: If you have created multiple Estimates for this project they are sortable in the 
“Record” column of the Estimate list. 
Note 2: You can also select all items by clicking the box at the top left of the list to select 
all at once. 

 
Estimate Items window opened with Check Box and Save buttons indicated 

c) Select all the Estimate Items and then click the “Save and Exit.” 
 

14.  The Clauses view needs to be set up with standard clauses included in every BU 
procurement. To do this: 

i. Click on the Clauses tab. 
ii. Click on the “+ Add Clause(s)” button. 

              

 
Add Clause(s) button 

iii. In the window that opens, select “Group ID” from the “Group by” dropdown. 
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Group By > Group ID 

iv. Select the “001 – Completeness of RFP”  and “002 – Contract Terms” folders on the 
left hand side of the page, and then drag them over to the right-hand side 

 
Moving the folders from the list on the left to the right. 

Click the “Save” button at top of the window. 

 
Open the Clauses for editing and check off the “Include in Bid” box. 
Note: If you do not complete this step the Clauses won’t be properly displayed on the “Online 
Bid” records for the Project. 
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“Include in Bid” column and selection boxes indicated 

15. Change the Workflow Status/Revision drop-down on the Main window to “Approved,” and 
save the record. 

 
Workflow Status/Revision 

16. In the top bar click the down-arrow next to Generate and click on “Procurement.” 

 
Generate > Procurement. 

17. In the window that opens click the box next to the types of Procurements you wish to 
generate from this Pre-Bid, and click the lightning bolt to Generate Records. 
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Generate Procurement Records window and Lightning Bold 

18. Click the “X” button to close the window afterwards. 

The system has now generated a new Bid Packages record for each of the Categories that you 
indicated.  The system will break down each Bid Package by the Category(s) that were selected for 
the Estimate Items. 

 

Bid Packages (formerly Procurement) 

The Bid Packages record holds the Bid Matrix, as well as where you manage the bids that you have sent 
out.  From here you can add in both Clauses and Scoring to the Bid Package, as well as issue and level the 
bids. 

A Bid Package record can either be created through a Pre-Bid record, directly from an Estimate Record, or 
by adding the lines of an Estimate to a pre-existing Procurement Record.  Each method is detailed below. 

Generating a Bid Package Record from an Estimate 

Use the main menu to navigate to Planning / Portfolio Planning / Estimates 

 
Planning > Portfolio Planning > Estimates 

1. Open the Estimate you wish to Generate your Procurement record from. 

 



81 | P a g e  
 

2. In the header of the Estimate, check to make sure that the Estimate is 
“Approved” by checking the Status field. 

 
Approved Estimate Record 

Note: If the Estimate is not “Approved”, change the Status to “Approved” and 

save the change, by clicking the “Save”  button.  
3. In the toolbar at the top of the record, click the down arrow next to 

“Generate.”   Select “Generate Procurements” from that list. 

 
Generate Procurements 

4. The “Procurements” window opens. 

 

Procurement window 

5. Click the blue box, removing the check mark, next to the Bid Categories that 
you do not want to send bids out for. 

 
Single Bid Category selected 

6. Click the “Generate” button at the top-left of the window to create the Bid 
Packages record(s). Navigate to Planning > Procurement > Bid Packages 
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Planning > Procurement > Bid Packages  
7. Locate your generated Bid Package by filtering the list by your Project Name or 

Number, and then looking for the record with a blank Description field.. 

 
“Generated” record on Bid Package List 

8. Open the record by double-clicking on the line. 
9. Enter a Description of the Bid Package that you will recognize. 
10. In the Solicited By drop-down select Boston University. 
11. In the Project Manager drop-down, select your name. 
12. In the Commitment Type selection, choose the Type of Agreement that will be 

signed once this Bid Package is completed. 
13. The Revision Date field is auto-populated by the system, to track versioning. 
14. In the Bids Due field select the date that the bid is due. 
15. In the Time field select the time that the bid is due.  

Note 1: The countdown clock on the bid starts when this value is saved.  If you don’t 
know the exact due date of the bid, when you are creating the record, do not enter 
these values until after completing the record. 
WARNING: Do not enter the Bids Due Date and Time until you are ready to Issue the 
bid.  These fields cannot be modified once information is entered, and the record is 
saved. 



83 | P a g e  
 

   

Completed Bid Package Header 

16. Click the “Save” button at the top of the page. 

Populating a Bid Package Record without a Pre-Bid or Estimate 

Note: If you have created a Pre-Bid record and then “Generated” Bid Package records from 
the Pre-Bid, or “Generated” a Bid Package record from an Estimate, skip this section and go 
to “Setting up the Bidder Matrix, Items and Scoring.” 

 
1. Navigate to Planning > Procurement > Bid Packages 

 
Planning > Procurement > Bid Packages 

2. Click on the “+Add” button at the top of the list page.  
Note: If this is the first Bid Package record created that you have access to, then you 
will be brought directly to the Bid Package screen. 

 
“+” button on the Bid Package List 
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3. Select the Program of the Project from the drop-down list.  
4. Select the name of the Project from the drop down list. 
5. Do not modify the Procurement # as it will affect all future records created in the 

system. 
6. Enter a Description of the Bid Package that you will recognize. 
7. In the Solicited By drop-down, select Boston University. 
8. In the Project Manager drop-down, select the name of the Project Manager. 
9. In the Commitment Type selection, choose the Type of Agreement that will be 

signed once this Bid Package is completed. 
10. The Revision Date field is auto-populated by the system, to track versioning. 
11. In the Bids Due field select the date that the bid is due. 
12. In the Time field select the time that the bid is due.  

Note 2: The countdown clock on the bid starts when this value is saved.  If you don’t 
know the exact due date of the bid, when you are creating the record, do not enter 
these values until after completing the record. 
WARNING: Do not enter the Bids Due Date and Time until you are ready to Issue the 
bid.  These fields cannot be modified once information is entered, and the record is 
saved. 

13. Click the “Save” button at the top of the page. 

 
Completed Header with fields indicated 

14. Validate that the default “Options” in that section of the record are correct for your 
project.  If not they can only be modified by the system administrator. 
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 This is a Sealed Bid – Seals bids until after they are due (defaults to 
checked) 

 Lock Online Bids After Bids Due – Bidders cannot modify their bids 
after the due date (defaults to checked). 

 Include Days Column in Online Bids 

 Include MWDBE % Column in Online Bids 

 Include Manufacturer Columns in Online Bids 

 Include Bid Item UDFs in Online Bids 

 Require Acknowledgements 

 Require Nondisclosure Agreement – Bidders must sign an NDA before  

 Show Bid Due Countdown Clock 

 Lock Quantity in Online Bids  

Setting up the Bidder Matrix, Bid Items, Clauses and Scoring 

Setting up Bidder Matrix 

15. The Main View is where you add your bidders and award the winner. To add 
bidders to this list. 

 

Main View with Bidder List shown 

Note: As you add bidders to the list Online Bidding records will be created.  When the 
bids are Sealed, only the contact from the assigned company will be able to view the bid. 
Not even the system admin can see Sealed bids in projects@BU Prior to the close of 
Bidding. 
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Bidder Matrix List 

a. On the table header click “+ Add Bidders.”  

 
“+ Add Bidders” button indicated 

b. The Select Companies/Contacts window will open. 

 
“Select Companies/Contacts” window. 

c. Click the Checkbox to the left of the bidders that you wish to add to 
the bid.  After you have selected the bidders, click the “Save and 
Close” button. 
Note: While BU requires that a minimum of three (3) bids be received 
for each project, not all bidders will accept the bid. It is recommended 
you send out more than the required number of bids. 
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Bidders checked off, with checkbox indicated, and  

“Save and Close” button indicated. 

 

Bid Items 

Click on the Bid Items View to add either Items from your Estimate to the Bid Package record, or 
add Items directly to the Bid.  

 

Bid Items View 

16. To add Items from your Estimate: 
 

a. Click on the “Add Estimate Items” button on the top of the list. 

 
“Add Estimate Items” button Indicated 

b. In the “Estimate Items” window that opens, click on the checkbox next 
to the Estimate line(s) that you wish to add to the Bid. 
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“Estimate Items” window open, with checkbox indicated. 

c. Click on Save and Exit  at the top of the page to close the window 
and add the items to the Bid Package. 

 
17. To add Items from the Items List. 

a. Click the “Add Items” button 

 

“Add Items” button indicated. 

b. The Items dialog opens. 

 
c. Expanding the Items Catalog folder shows the general categories that 

Items are broken into by the type of Costs they represent, either 
Construction, Owner Controlled or Contingency. 

 
d. Expanding, for example, the Owner Controlled Costs folder by clicking 

the arrow next to it, shows the three phases that Cost Codes are 
separated into. 
Note: For single-phase Projects, pick the “Phase 1” folder. 
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e. The next set of sub-folders that contain all the Owner Controlled Cost 

Groups, including Design Fees, FF&E, Security, and Insurance. 

  
f. Expanding, for example, the sub-folder 50 Design Fees shows the 

Design-related cost centers. 

 
18. Click the appropriate cost item(s) and drag them from the Catalog on the left to the 

table on the right. 
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Drag the Cost Codes you have selected on the left to the table on the right. 

          

 
The Cost codes now appear in the table. 

19. Click the Save and exit button in the Items dialog box.  

Adding Clauses to a Bid Package Record 

20.  The Clauses view needs to be set up with standard clauses included in every BU 
procurement to do this: 

a. Click on the Clauses view. 

 

Clauses View 

b. Click on the “+ Add Clause(s)” button. 

 
 “+ Add Clause(s)” button 

c. In the window that opens, select “Group ID” from the “Group by” 
dropdown. 
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Group By > Group ID 

d. Select the “001 – Completeness of RFP”  and “002 – Contract Terms” 
folders on the left hand side of the page, and then drag them over to 
the right-hand side 

 
Moving the folders from the list on the left to the right. 

21. Click the “Save and Exit”  button at the bottom of the window. 
22. Click the selection box on the far left of each line under “Include in Bid.” 

Note: If you do not complete this step the Clauses won’t be properly displayed on 
the “Online Bid” records for the Project. 

 
“Include in Bid” column and selection boxes indicated 
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Add Documents to the Bid Package 

23. After adding Bid Documents to the Document Manager they need to be attached to 
the Bid Package record through the Attachments view, and then shared with 
Bidders to be visible. 
Note: These steps can also be followed to add documents during the bidding 
process. 

a. Click on the Attachments view. 

 

Attachments View 

b. Click on the “+ Add”  button at the top of the page. 

 

Folder Icon 

c. After clicking on the Folder icon you will get a list of options in the 
center of your screen. Click on “From Document Manager” 

 

Add Document Options 

d. The Document Manager window will open displaying the top folder of 
the project. 

 

Document Manager window 
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e. Navigate through the folder structure by double-clicking on the folder 
you wish to open to where the bid documents are stored. 

 

Sample in 01 Administrative > 101 Proposals shown 

f. Single click on the files you wish to add to the bid. As you do a 
checkmark will appear on each file showing that it has been selected. 

 

File Selection: Right file is selected, left is not 

g. Click the “Save and Exit”  button at the top of the window to 
save these files to the bid. 

i. To share these documents with your Online Bidders. 
1. Select the Document that you would like to share, 

and click the “Details” switch at the top of the 
window. 

 

Details switch 

ii. The Details window will open on the right-hand side of the 
screen. 
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Details window 

iii. Click the Edit button on in the details window. 

 

Edit Details Button 

iv. Click the “Include in Bid” switch. 

 

“Include in Bid” switch 

v. Click the “Save” button in the Details window to save your 
change. 

 

Add Scoring questions to the Bid Package Record 
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24. The final step before launching the Bid is to add Scoring to the bid package. Scoring 
is a set of questions, broken down by bid type, for example Architect, that the 
Bidders must complete which help you rate the Company sending you the bid, the 
team from that Company, and any other criteria you need to evaluate to select a 
vendor. You add and manage this from the Scoring tab. 

a. Click on the Scoring view. 

 
Scoring tab. 

b. In the toolbar at the top of the list, click the “+ Add Scoring” button. 

 
Toolbar shown, with “+Add Scoring” indicated. 

c. In the “Group By” dropdown select “Group Description” to group the 
Scoring questions by type of Bidder. 

 
d. Drag the folder for the appropriate type of bidder from the list on the 

left to the right hand side of the window. 

 
Dragging scoring questions from the List to the Bid 



96 | P a g e  
 

e. Click the “Save and Exit”  button at the bottom of the window. 
f. The window will close, and the scoring questions will be added to the 

bid. 

 
Scoring questions added to bid. 

Note: If you have specific questions for bidders that are not covered by either 
Clauses or Scoring, you can add them through the scoring tab, in the “Online Bid 
User Defined Fields” Section in the Clauses View. 

25. Bid documentation or notes should be added to either the Attachments or Notes 
tabs of the bid, making sure to click the “Include in bid” checkbox to include them in 
the Online Bidding records.  This is where Drawings, Specs, or other project 
information should be included in the Bid Package. 

Issuing a Bid and Responding to Questions during the Bid Process 

Once a bid package has been completed, follow these steps to start the bid clock, and issue the invitations 
to the bidders. 

Note: You can use these same steps to send out updates and answers to bidder questions during the 
bidding process. 

Steps 

26. Find the Bids Due and Time fields in the Main View and select the appropriate 
date/time the bids are due, and click the “Save” button.  Once this step is complete 
you will see the “Bid Due” countdown clock appear at the left. 

 
Bid Due Clock 

27. Once you have saved the Bids Due date and time, click on the “Notifications”  
Icon in the toolbar at the top of the page. 
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Notifications Icon Indicated 

a. The Primary contact for each bidder will be auto-populated in the BCC section of 
the Notification. 

 
Bidders in BCC. 

Add your name to the To: section so that you will be copied on the notification 

using the ellipsis  on the left side of the To section. 

 
To section with PM Name 

b. From the Notification Type select “Invitation to Bid” 

 
Notification Type set to “Invitation to Bid” 

c. The text of the Notification populates with the default version, but this can be 
deleted and replaced with the BU standard invitation to bid text. 

d. Click the “Send” button at the top of the window. 

Reviewing Submitted Bids 

Once the bid clock has finished running down, if the bids are sealed, they will be unsealed and you will be 
able to read the submissions as well as level the bids.  Otherwise Bids are viewable by the Project 
Manager throughout the Bidding Process. 

 This next section shows you how to review and level the bids as well as award the winning bid. 

Steps 

 
Navigate back to the Bid Package record that you created previously. 

28. Click on the Bid Items view to see the line-by-line comparison of each bid. 
Note: You may need to scroll to the right to see the Bid Totals (shown below). 
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Bid Items view with three sample bids represented, as well as estimate baseline. 

29. The “…” button next to the name of each bidder allows you to change the selected 
bid from each bidder, if they were reissued bids, as well as check which bid is 
currently being displayed. 

 
“…” button indicated. 

30. To navigate to the individual bids, click on the Manage Bids tab, and then click on 
the blue Bid # link to go directly to the individual bid. 
Note 1: If you need to level the bids or rate their scoring questions, click on the 
checkbox in the Lock column to unlock the bids for editing. If you do not unlock them 
you will not be able to make any modifications to the bids post-submission. 

  

  
Lock column indicated.  

Note 2: If you only want to view the latest bid from each click on the “Latest 
Revision Only” checkmark at the top of the list. 
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Manage Bids with bid links shown, and “Latest Revision Only” indicated. 

31. Once you have navigated to an individual Online Bidding record, you have several 
pieces to review. 
a. The Main view holds the numeric values of the Bidders entry. 

a. Read through each line of the bid, and note any outlying bid values. 
b. Click on the ellipsis icon next to the Leveled Total value, and the “Bid 

Leveling” window will open with a graph comparing the Estimate, Bid, 
and Leveled values against each other. 

 
“Leveled Total” with leveling ellipsis indicated 

                    
Bid Leveling Window 

c. This window has several important sections, and pieces of 
information. The sections are divided into: 

i. Estimated – The original Estimate for that Cost Code. 
ii. Bid – The current Online Bid values for that Cost Code on this 

bid. 
iii. Leveled – The Leveled value of the Online Bid for that Cost 

Code, if applicable. 
d. Each section has several fields: 

i. UOM – The unit of measure for that line. 
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ii. Quantity – The Quantity of the line from the Estimate or 
Online Bid 

iii. Unit Price – The price per unit of the line from the Estimate 
or Online Bid. 

iv. Estimated/Bid/Leveled Total – The Quantity x Unit price of 
that line in the Estimate or Online Bid. 

 
Bid Leveling Window Sections indicated. 

e. If there are any outlying values, if needed, reach out to the bidder to 
confirm that they wished to submit the value entered.  If they did not 
you can either Level the bid if one or two values need to be adjusted, 
or re-issue the bid if the entire bid needs to be changed. 

i. To Level the bid: 

1. Click on the ellipsis  next to the value in the 
Leveled Total column. 

2. Click the “+ Add” button at the top of the leveled list. 
3. In the line that appears enter the: 

a. Description – The reason why leveling is 
being applied. 

b. Leveled Amount – The amount the bid is 
being leveled by.  Enter a positive (+) value 
to increase the amount of the bid, a 
negative (-) value to decrease the amount. 

c. Click the “Save” button. 

 
Bid Leveled with a positive (+) value. 

f. Close the Bid Leveling window by clicking the “X” at the top right of 
the window. 
Note: Once you close the window, you will notice that the line you just 
edited is now highlighted in black.  This indicates to anyone reviewing 
the bid that this line has been leveled. 
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Bid Leveled indicated with highlight 

32. The Scoring view holds the bidders answers to the Scoring questions.  To review and 
rate these answers: 

a. Click on the Scoring tab. 
b. Click on the first line, hold shift and click on the last line, then click the 

“Edit” button to open all the lines for rating. 
c. Review the Bidder’s answers in the Answer column, and then add your 

own score to the Score column. 
Note: Do not exceed the Points Available for each line, as this will 
skew the final score. 

 
Answer, Score, and Points Available Columns Indicated. 

d. Click the “Update Records” button. 

Awarding the Winning Bid, and notifying all Bidders of their Status 

After you have leveled and reviewed the current bids, click on the Main window. 
33. Click on the line of the winning Online Bid, and then click the “Award” button. 
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Bid Selected, “Award” button indicated. 

34. Click on the Notification button in the toolbar at the top of the record. 
35. In the BCC, remove the name of the winning bidder. 
36. In the To field add your name. 
37. Click the Send button at the top of the page. 

Note: This process may change in the future after the integrations with SAP and 
Ariba have completed. 
Note: After awarding the bid, go to the “Generating a Commitment from an 
Awarded Procurement Record” section of this user guide for steps to create the 
associated Commitment record. 

 

Online Bidding 

The Online Bidding record is where external vendors bid on BU construction projects. Vendors can only 
see bids they have been offered. If a bid is sealed, not even the System Administrator is able to view the 
Bids. 

Accepting an Online Bid 

The first step to reply to a bid is to review the Bidding information and accept the online bid. 

Note: For any questions during the Bidding process, please send an email to the Project Manager issuing 
the bid.  They will reply back with a Notification from PMWeb linking you to the document containing your 
question and answer. 

Steps 

1. In the menu on the left-hand side of the page, navigate to Planning > Procurement > Online 
Bids. 

 

Planning > Procurement > Online Bidding 

2. You will be brought to the list of Online Bids that you have been invited to. (This list includes 
bids you have previously responded to.) 
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Online Bid List 

3. Double click the line that corresponds to the bid you are entering to open the record. 

 
 

Initial bid view 

4. The Bid # and Procurement number correspond to your bid and Project, and are locked and 
cannot be edited. 

5. The Program is the group (Department or School/College) within Boston University that the 
project is for. 

6. The Project is the BU name of the construction project. 
7. Type in a Description holds the name of your bid, entered after accepting the invitation. 
8. The Bid Category tells you what type of bid you will be entering. 

 

Completed Description with Program, Project, and Bid Category fields indicated. 

9. The Revision line tracks the date and time you last revised this bid. 
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10. The Bids Due line tells you when the bids are due. 
Note: This information can also be obtained from the bid Countdown Clock on the right side 
of the header. 

i.  
11. Countdown Clock 
12. In the Bidder Information section of the header are several key pieces of data. 

i. The name of your Company in the system. 
ii. The Bid Total that you are submitting.  (This value is the sum of all the lines entered 

in the Bid) 
iii. The 0.00 Amount Lines tells you the number of lines in the bid that you have not yet 

entered a value for. 
iv. The “Acknowledged” section shows you the number of Acknowledgements 

Remaining that you must fill out and/or accept prior to submitting the bid. 

 
Bidder information section 

13. Click on the “Accept Invitation” button to begin entering the bid. 
Note: If you do not wish to accept this invitation, click the “Decline Invitation” button.  In the 
pop-up window that opens, click the “OK” button to confirm. 
  
Note 2: If you do not wish to be contacted by BU on any future bids, click the checkbox on 
this page, and it will inactivate your account in projects@BU, and not allow you to be added 
to bids unless you request the removal of the flag. 
  

 

 
Accept/Decline Invitation Button 

Responding to an Online Bid 

The tabs below the header are where you enter your response to the bid. 
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Steps 

14. In the Description field, enter a name for your bid that both yourself and the BU Project 
Manager will recognize, and then Save the record. 

15. The Main view holds the line items that you will be bidding on separated by Cost (CSI) Codes.  
To respond to each of these lines: 

i. Click on the Unit Price field and enter your value for each of the lines. 
Note: The Total Amount column will auto-update with the Unit Price x Bid Quantity 
once the Price has been entered. 

ii. If you have additional information about these lines, enter it into the Notes column. 

iii. Click the “Save” button  at the top of the page to save your entries into these 
lines. 
Note: If you move away from this view before clicking the save button all your 
changes will be lost. 
You can tell when this is saved by the Bid totals being updated, and the number of 
“0.00 Amount Lines” value is 0. 

 

Completed Bid lines 

16. Click the Clauses view to review the standard Clauses for any BU Construction Contract 
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Clauses Tab 

To view the full text of each clause, click the ellipses  in the “TEXT” column to get a 
window with the full text. 

 

17. Click to the Scoring view to answer standard Scoring questions regarding your company, 
project approach, and team.  Enter these answers by double-clicking on the Answer field for 
each line, and entering in your response, and then clicking on the “Update Records” button. 
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Scoring Tab 

18. On the Attachments view you will find the Bid Documentation for the Project you are 
bidding on.  To download the documents on the Bid, click the double-down arrows on the 
right side of the file name, and a Save window will open prompting you to choose where to 
save the file. 

 

Attachments view with download icon indicated. 

19. Click on the Submission view to accept the BU standard clauses, as well as enter in the 
Bidding Contact and Expiration information. 

i. In the Bidder Information section enter: 
1. The Contact name for your bid. 
2. The date the Bid Expires by click on the calendar icon next to 

the field. 

 
Bid Expires with calendar indicated. 

3. The date you are Available to Start work on the Project. 
4. The Phone number, and extension if applicable, your contact 

can best be reached at. 
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Completed Bidder Information section 

ii. In the Acknowledgements section locate the “Clauses” in the Type 
field and click the check box on the left of each clause. 

Note: This section can be located after the “Bid Items” list, and contains 
standard Clauses for all BU construction bids. 

 

20.  Click the “Save” button at the top of the page to save these entries. 
21. Once all sections have been completed, the Acknowledgements Remaining number will 

drop to zero (0), click the “Submit Bid” button to submit you bid for the project. 
22. In the pop-up window that opens, click the “Ok” button to confirm your submission. 

Note: If you have not yet completed any sections, clicking the “Accept” button will bring you 
to the Acknowledgements section under the Submissions view where you can review the 
outstanding items. 
WARNING: Once you SUBMIT your bid you will not be able to modify it unless it is reissued to 
you by the BU Project Manager. 
 

 
“Submit” button.  
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Engineering Forms 

The Engineering Forms Module in projects@BU holds forms and transmittals that are generated as a Construction 
Project progresses.  Submittals, Meeting Minutes, Drawing Sets, and Punch Lists are all stored here and are 
available to reference for anyone who has access to these sections of the system.  The Document Manager, the 
central repository for all files generated by/for all projects is also located in this Module. 

This section of this User Guide goes through each of the record types that BU is using in this Module and walks 
through how they are used at Boston University. 

RFI’s 

RFI’s track questions and answers from either the Internal Service Providers or External Service Partners 
which may have a Scope, Schedule and/or Cost impact to the overall Project. 

Creating an RFI  

1. Navigate to Engineering Forms > RFIs 

   
Engineering Forms > RFIs 

2. Click on the “+”  button at the top of the list page. 
Note: If this is the first RFI created that you have access to, then you will be brought 
directly to the RFI screen. 

 

“+” button on RFI List 

3. Select the Project from the dropdown list at the top of the Page. 
4. The RFI # field is not locked, but should be left at the system generated value. 

Note: If you override this field, subsequent RFIs will follow the overridden sequence. 
5. In the Description field type in an easy-to-recognize name for this RFI. 
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6. Click the “Save” button at the top of the page to save this RFI and link it to the project data. 

 

Save button indicated 

7. In the RFI Date field, enter in the date the question causing the RFI was first raised. 
8. In the CSI Code dropdown select the CSI group that this RFI record pertains to. 
9. In the From dropdown select your name/company. 
10. In the To dropdown select the person you are sending this RFI to. 

 
From and To Dropdown list shown. 

11. Select the Priority of the RFI that you are submitting. 
12. Select the schedule Task that this RFI impacts. 

Note 1: If there is not a Schedule for this Project, then the task list will be blank. 
Note 2: If this list does not populate and there is a Schedule, click the Save button at the top 
of the screen to save the record and link it to the project. 

13. The next three checkboxes indicate if the RFI: 
i. Affects Scope of Work 

ii. Affects Cost 
iii. Affects Schedule 

14. Click the calendar icon next to Date Required to select the date you require an answer by. 
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Calendar open. 

15. Click the Save button at the top of the page. 

 
Completed RFI Main Data 

16. In the Question box, enter in the full description of your request. 
Note: This box has full formatting functionality for ease of entering. 

      
Formatted RFI Question Entry 

17. In the Proposed Solution box on the “Details” enter in the solution for the issue this RFI 
pertains to if one is known or being considered. 

 
RFI Solution Entry 

18. Save this record by clicking the Save button in the toolbar at the top of the page. 
19. Click the Submit button at the top of the page. 
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Save and “Submit” buttons indicated. 

20. The SUBMIT window will appear, and you can enter any Comments needed in the box. 
21. Click the Save and Exit button to submit the Request to Workflow.  

 

SUBMIT window with Save and Exit button indicated. 

Responding to a Submitted RFI 

If an RFI has been submitted to you for your commentary, you will receive a workflow 
notification. 
22. Navigate to Engineering Forms > RFIs 

 
Controls Page with RFI notification 
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23. Note: If you are in the system you can navigate directly to the RFI submitted to you via the 
Workflow Inbox. 

24. Read through the Question and Proposed Solution section of the RFI, and respond back in 
the Answer section of the page. 

Note: This box has full formatting for ease of entering. 
25. Enter in the date you answered the question in the Date Answered box to the left the 

Answer section. 
26. If this answer effects the Scope of Work, Cost, and/or Schedule, then check off the 

appropriate marks below the Answer section. 

 
Answer entered with Date Answered and Effects section highlighted 

27. Click the “Save” button at the top of the page. 

 
Save button 

Meeting Minutes 

The Meeting Minutes record type in projects@BU allows you to record Project Tasks in a centralized, 
reportable location.  This allows everyone who has access to the project to have the same task list from all 
meetings.  Meeting Minutes records can be generated by several roles including the Project Manager, 
Architect and General Contractor, allowing individuals outside of the Project Manager to input their own 
task list from meetings where the Project Manager may or may not have been in attendance, allowing the 
PM a more informed view of their project. 

Creating the record 

1. Navigate to Engineering Forms > Meeting Minutes 
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Engineering Forms > Meeting Minutes 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Meeting Minute record you have generated or have access 
to then this step will not be necessary, you will be brought directly to the record 
view. 

 

 
Meeting minute toolbar with “+” button at the top. 

Note 2: If you wish to generate a new Meeting Minute record for a project, select the 
last Meeting Minute record for that project and then click the “Create Next Button 
 

 

Create Next Button Shown 

3. In the Project* dropdown search for the name of your Project. 
4. Select the Phase of the project in the Phase dropdown. 
5. In Type select the meeting type the minutes are for. 

 
Type drop-down open showing options. 

2. The Record # is automatically created by the system and should be left at the system 
generated value. 

3. The Meeting # field populates automatically. 
4. Enter the name of the meeting in the Description field. 
5. Enter the location of the meeting in the Location field. 
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Note: This is a free-text field and does not link with the list of building addresses at 
BU. 

6. If known, enter the project number from the vendor in the Vendor Project Number field. 
7. The Category field is not currently in use. 
8. The Meeting Date field auto-populates with the current date, but can be changed by clicking 

on the calendar icon and selecting a different date. 

 
Meeting date calendar open. 

9. Enter in the Start and End time of the meeting in the Started and Ended fields, by clicking on 
the clock and selecting the appropriate time. 

 
Clock highlighted and options shown. 

10. In the Next Meeting section, enter in the Location, Date and Start Time of the next project 
meeting, if known. 

      
Next meeting box filled out. 

11. Click the Save button at the top of the record. 

 

Save button indicated. 

12. The Participants section of the header holds a list of the potential attendees of the meeting. 
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Participants List 

i. Click the “+ Add Multiple” button  to add 
attendees to the meeting. 

ii. The “Select Companies/Contacts” window opens. 

 
iii. Click the check box to the left of the contact row to select the 

participants, the box will be then filled in to show selected 
attendees. 

iv. Click the “Save and Close” button at the top of the list to 
close the window and add the Participants to the header. 

v. Highlight the rows in the participant list and click the “Edit” 
button. 

vi. Click the box to the right of each Participant in the “Present” 
column to mark them as attending the meeting, and then 
click “Update Records” 

 
Participant marked as “Present” 

13. Click the “Save” button in the toolbar at the top of the page. 
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Header completed, “Save” button highlighted. 

Entering Tasks from a Meeting 

14. In the task list at the bottom of the page click the “+ Add” button. 

  
Details table with “+ Add” button highlighted. 

15. Enter the order of tasks in the Seq # field.  
16. In the Description field, enter in the description of the Task. 

Note: This field has full formatting capability for ease of entering information. 

         
Description field selected with options shown. 

17. In the Assigned To field, select the name of the person who the Task is assigned to. 
Note: Tasks can only be assigned to those who are set up as a contact in the system. 

18. The Category  field is not currently in use. 
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19. In the Subject field, give the Task a name. 
20. The Status field is not currently in use. 
21. Enter the due date of the Task in the Due field. 
22. If this Task is associated with a line from the Project Schedule, click the Task drop down and 

select the appropriate entry. 

 
Completed Task entry 

23. Click the “Update Records” button at the top left of the list. 

 
Save button indicated 

24. Repeat steps 18 – 28 for each additional Task line. 

Completing Tasks 

Once Task(s) have been completed, follow these steps to complete them in the system. 

25. Navigate to the meeting your Task is associated with. 
26. Select the line for your Task, and click the “Edit” button. 
27. Enter in the Completion date in the Completed field. 
28. If you have any comments about the completion of the Task, enter them into the Notes 

field. 
29. Click on the check-box in the Done column. 

 
Completed Task 

30. Click the “Update Records” button at the top left of the list. 
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Drawing Sets 

Drawing sets allow users in projects@BU to group together multiple drawings from the Document 
Manager into a single transmittal that can be reported on and easily located. 

Creating a Record 

1. Navigate to Engineering Forms > Drawing Sets. 

 

Engineering Forms > Drawing Sets 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Drawing Sets record you have generated or have access to 
then this step will not be necessary, you will be brought directly to the record view. 
          

 

Drawing Sets toolbar with “+ Add” button at the top. 
3.  In the Project* dropdown search for the name of your Project. 
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4. Select the current Phase of the Project. 
5. The Set # field is locked and populated by the system 
6. Enter in a title of the Drawing Set in the Description field. 
7. In the From drop-down search for your name. 

 
From drop-down open showing options. 

8. In the CSI Code drop-down select the appropriate values for the Drawing Set. 

 
CSI Code list highlighted with options shown. 

9. In the CSI Division select the division this Drawing Set applies to. 

 
CSI Division list 

10. Click the “Save” button at the top of the record. 
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Completed Header with Save button Highlighted. 

Adding Drawings to the Set 

11. If you have added Drawings to the Drawing Lists record:  
i. In the list, click on the “+ Link Drawings” 

 
“Link Drawings” button indicated. 

ii. A list of all the Drawings in the Drawing Lists record for the 
Project will appear. 

 

Link Drawings Window 

iii. Click on the Check Mark next to the Drawings that you want 
to add to the set. 

iv. Click the “Save to Record” button to save the lists to the  
12. If you have not added Drawings to the Drawings List record: 

i. Click the “+ Add” button at the top of the list, a new line will 
be added shaded in a yellow color. 

 
ii. In the Date field select the date of the drawing. 

iii. In the Description Field enter a brief description of the 
drawing. 

iv. Select the appropriate CSI Division and CSI Code in the next 
drop-downs. 

v. The Category dropdown has been left blank at this time and 
will be populated later. 

vi. If this drawing is related to a particular Schedule task, select 
it from the Task dropdown. 
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vii. Click the “Save”  button to save this line. 

viii. Click the grey document link, and the “View Attachments” 
window will open. 

 
Attachments link Indicated 

   
 

 
View Attachments window 

ix. You have two options from here. 
x. Drag and Drop 

1. Locate the file on your computer. 
2. Click-and-drag the file to the “Drop Files Here to 

Upload” green box. 
Note: You will know you have dragged correctly when your cursor turns 
into an expanded version of the file icon. 

                                    
xi. Attach from Document Manager 

1. Click the “Attach from Document Manager” button 
2. In the window that opens navigate to your file and 

click “Open” 
3. Once a file has been uploaded to projects@BU it will 

appear in the list above the green upload box. 
xii. Click on the “Save & Exit” button on the toolbar at the top of 

the page to save the record. 
13. Click on the “Save” button on the toolbar at the top of the page to save the record. 
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Submittal Sets 

Submittal Sets are how BU processes Submittals from vendors through projects@BU.  This provides a 
central location of all Submittals for one project, and also allows groups of these records to be bundled 
into a Transmittal (see Transmittals section). 

Note: If the lines you are adding do not correspond to a Cost Code, after completing the “Creating the 
Header” steps, jump directly to “Completing lines on the Submittal Set.” 

Creating the Header  

1. Navigate to Engineering Forms > Submittal Sets. 

 
Engineering Forms > Submittal Sets 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Submittal Set record you have generated or have access to then this 
step will not be necessary, you will be brought directly to the record view. 

 

Submittal Sets toolbar with “+ Add” button at the top. 
3. In the Project* dropdown search for the name of your Project. 
4. The Set #* field is populated by the system and should be left at the generated value. 
5. Enter a Description of the Submittal Set that will be recognizable by both yourself and other 

members of the project team. 
6. In the From drop-down, select your name. 
7. In the To drop-down, select name of the person you are sending the Submittal Set to. 
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To/From Drop-down 

 

8. Enter the name of the GC or Subcontractor in the Responsible Contractor field, who will be 
in charge of the work from this Submittal Set. 

Note: As most Sub contractors will not be users or contacts in projects@BU, this is a 
manual entry field. 

9. Click the “Save” button at the top of the page. 
 

 

Completed Submittal Set Header with “Save” button indicated. 

10. The Closed Lines list is the number of “Approved” line items compared to the total of lines 
on the Submittal Set. 

 

Closed lines indicator 
 

Adding Items to the Submittal Set 

11. In the toolbar of the Details table click the Add Items button.  In the Details tab, click the 
“Add Items” button, and the Items dialog opens.  

 
“Add Items” button indicated.  
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Items Catalog 

12. Expanding the Items Catalog folder shows the general categories that Items are broken into 
by the type of Costs they represent, either Construction, Owner Controlled or Contingency. 

 
13. Expanding, for example, the 01 Construction folder by clicking the arrow next to it, shows 

the three phases that Cost Codes are separated into. 
Note: For single-phase Projects, pick the “Phase 1” folder. 

 
14. The next set of sub-folders that contain all the Owner Controlled Cost Groups, including 

Design Fees, FF&E, Security, and Insurance. 

   
15. Expanding, for example, the sub-folder 50 Design Fees shows the Design-related cost 

centers. 
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Expanding the 06 Concrete Folder 

16. Click the appropriate cost item(s) and drag them from the Catalog on the left to the table on 
the right. 

    
Drag the Cost Codes you have selected on the left to the table on the right. 

  
The Cost codes now appear in the table. 

17. Click the “Save and Exit” button in the Items dialog box.   
18. The Items dialog closes and the new items appear in the Details table on the Submittal Set. 

Note: If the line(s) you are adding to the Submittal Set do not correspond to Cost Codes, click 
the “+ Add” button, manually enter a Description and then click the “Save” button. 
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 Completing lines on the Submittal Set and attaching Documents 

19. Open the lines for editing. 

 
Items selected for editing and “Edit” button indicated. 

20. If there is a specific status for these submittal items, select it from the Status column. 
21. Select the task in the Schedule that these items are tied to in the Task column. This will also 

auto-populate both the Start and Finish. 
22. The Lead Time field is not used. 
23. In the Sent and Return Due dates enter the date that the Submittal Set was sent to the 

receiver and when it is due. 
24. The Due Date auto-populates with the date the Task is scheduled to be completed, but can 

be modified by the submitter. 
25. Enter any specific Notes that you wish to have on these lines in the Note column. 
26. Click the “Update Records” button. 

 
“Update Records” button indicated. 

27. To attach documents to the Submittal Set lines, follow these steps. 
i. Click the grey document link, and the “View Attachments” window will open. 

 
Attachments link indicated

 
View Attachments window 

i. You have two options from here. 
ii. Drag and Drop 

a. Locate the file on your computer. 
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b. Click-and-drag the file to the “Drop Files Here to Upload” green box. 
Note: You will know you have dragged correctly when your cursor turns 
into an expanded version of the file icon. 

                                    
iii. Attach from Document Manager 

c. Click the “Attach from Document Manager” button 
d. In the window that opens navigate to your file and click “Open” 
e. Once a file has been uploaded to projects@BU it will appear in the list 

above the green upload box. 
iv. Click on the “Save & Exit” button on the toolbar at the top of the page to save 

the record. 
28. Click on the “Save” button on the toolbar at the top of the page to save the record. 
29. Click the Submit button at the top of the record. 

 
30. Click the Save and Exit button to submit the Request to Workflow.  

 

SUBMIT window with Save and Exit button indicated. 
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Transmittals 

Transmittals in projects@BU allow you to package groups of documents or records from projects@BU 
into a single record to be sent to members of the Project team.  Transmittals can also be used to track the 
movement of physical files sent to and from those working on the project. 

Creating a Transmittal Package  

1. Navigate to Engineering Forms > Transmittals. 

 
Engineering Forms > Transmittals 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Transmittal record you have generated or have access to then this 
step will not be necessary, you will be brought directly to the record view. 

 

Transmittal toolbar with “+ Add” button at the top. 
3. In the Project* dropdown search for the name of your Project. 
4. Select the current Phase of the Project.  
5. The Transmittal # is populated automatically by the system and should be left at the system 

generated value. 
6. Enter in an appropriate Description of the Correspondence. 
7. In the To drop-down select the Project Team member you wish to send the Correspondence 

to. 
8. If the Transmittal is a physical document and being sent to a physical location, enter it into 

the Address box. 
Note: If there is an address for the Company of the selected contact in the system it will auto-
populate into this field. 

9. In the From drop-down select your name. 
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To/From drop-down and Address Box open showing options. 

10. The Category field will be populated after the system has been used for a period of time. 
11. If the Transmittal is being sent physically, the right-hand column holds multiple pieces of 

information.  Enter the Shipped Date, Shipped Time, Via (shipping method), Tracking 
Number, and Quantity 

12. In the Due Date enter the date the transmittal needs to arrive. 
13. Click the “Save” button at the top of the page. 

 
Completed Transmittal Header 

Adding Records to the Transmittal Package 

Once the header of the Transmittal record has been created you can either add items to the list directly, if 
they are physical items, or you can add any completed record from the Engineering Forms section of 
projects@BU to the transmittal. 

 
Transmittal List 
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Adding projects@BU Records to the Transmittal 

 
14. In the “Items” section of the Details table, click the “Add Link” button on the top of the 

Transmittal list. 

 
“Add Link” button on the Transmittal List 

15. The “Link Records” window opens.  

 
Link Records window   

16. Click the arrow button  next to the folder containing the projects@BU records you 
wish to add to the Transmittal. 

 

“Add Link” window with folders shown, and arrows indicated 

17. Drag the name of the item from the folder list on the left-hand side of the window. 
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Moving records from the folder list, to the Transmittal list. 

18. Click the “Save and Exit” button at the top-left of the window. 

 

Transmittal window with the “Save and Close” window. 

Note: Once you have added a projects@BU record to the Transmittal list, a link to that 
Transmittal now appears in the linked Documents list. 

  

Transmittals box on Submittal Sets. 
  

Adding Documents to the Transmittal 

19. In the “Items” section of the Details table, click the “+ Add” button on the top of the 
Transmittal list. 

 

Transmittal list with “+ Add” button indicated. 

20. Enter the name of the document in the Description field. 
21. Click the “Save” button. 
22. Click the grey document link, and the “View Attachments” window will open. 
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Attachments link indicated 

 

View Attachments window 

23. You have two options from here. 
i. Drag and Drop 

a. Locate the file on your computer. 
b. Click-and-drag the file to the “Drop Files Here to Upload” green box. 

Note: You will know you have dragged correctly when your cursor turns into an 
expanded version of the file icon. 

                                           
ii. Attach from Document Manager 

a. Click the “Attach from Document Manager” button 
b. In the window that opens navigate to your file and click “Open” 
c. Once a file has been uploaded to projects@BU it will appear in the list above 

the green upload box. 
iii. Click on the “Save & Exit” button on the toolbar at the top of the page to save the 

record. 
24. After you have entered the transmittal information, locate the Remarks section on the 

Details table. 
Note: You may need to scroll to the right of the page to find this section. 

    

Remarks section indicated. 

25. In the Remarks section, you will find several checkboxes that help inform the recipient of 
your transmittal of the reason for you sending it to them, these options are: 
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1. For your Use 
2. For your information 
3. For your records 
4. For your Approval 

26. Click the checkbox next to the Remarks type you wish to tag this Transmittal with, and click 
the “Save” button. 

27. Click the “Notifications” button to send an Email to the recipient of the Transmittal that 
the record has been completed. 

 

Correspondence 

The Correspondence record holds correspondence between members of the Project Team.  This 
correspondence is preferred instead of mail since it keeps all records in a central location and is accessible 
to both members of the Project Team as well as others in PDC. 

Note: Email is still used for communication with those people outside of projects@BU, as Correspondence, 
can only be shared with users in the system that have access to the record type. 

Creating a Correspondence Record 

1. Navigate to Engineering Forms > Correspondence. 

 

Engineering Forms > Correspondence 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Correspondence record you have generated or have access to 
then this step will not be necessary, you will be brought directly to the record view. 
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Correspondence toolbar with “+ Add” button at the top. 

3. In the Project* dropdown search for the name of your Project. 
4. Select the current Phase of the Project. 
5. Enter an appropriate Description of the Correspondence. 
6. In the To drop-down select name of the Project Team member the Correspondence is being 

sent to. 
7. In the From drop-down select your name. 

 

To/From drop-down open showing how the Companies and Contacts are displayed. 

8. The Category drop down is not in use yet. 
9. In the Priority drop-down select the priority level of this correspondence. 
10. Click the “Save” button in the header at the top of the page. 

 

Correspondence header completed and Save button indicated. 

11. In the Details table write out the text of the Correspondence you wish to send. 
Note: This correspondence field has full editing functionality allowing you to create a 
formatted correspondence just as you would with any email application. 
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Correspondence example filled out. 

12. Click the “Save” button at the top of the record. 

13. Click the “Notifications” icon  in the toolbar at the top of the window. 

 

Notifications icon indicated 

14. In the window that opens, select who you are sending the Transmittal to by clicking the 
ellipsis next to “To” and searching for their name. 

 

To field and Ellipsis indicated 

15. Click the Send Icon  to send the Notification to your recipient(s). 
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Punch Lists 

Punch lists are groups of items that are created towards the end of a construction project. They are 
managed by both the Project Manager and the General Contractor as a way of ensuring that all tasks, 
both large and small, which need to be completed prior to project closure, are documented and assigned. 

projects@BU allows for multiple Punch Lists per project. They can be grouped together, using Reporting, 
into a master Punch List, which is maintained by either the Project Manager or the OPM. 

Creating a Punch List Record Header 

1. Navigate to Engineering Forms > Punch Lists 

 

Engineering Forms > Punch Lists 

2. In the top of the list that appears click the “+”  button. 
Note: If this is the first Punch List record that you have created or have access then 
this step is not necessary, and you will be automatically brought to the new record 
view. 
 

 

Punch List with “+ Add” button highlighted. 

3. In the Project field, select the name of your project. 
4. Select the Phase of the Project this Punch List is for. 
5. The Punch List # is automatically populated by the system and should be left at the system 

generated value. 
6. In the Description field, name your Punch List something both you and the Project Team will 

recognize. 
7. In the From box, select your name in the list, and in the To box select the name, if applicable, 

of the project team member you are sending this Punch List to. 
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From/To box open with Contact List shown. 

2. If this Punch List pertains to a specific CSI Code select it from the dropdown. 
3. Category is not being used at this time. 
4. Select the appropriate Priority level (Low, Medium, or High) from the Priority drop-down. 
5. Click the “Save” button at the top of the record. 

 

Completed header with “Save” button highlighted. 

Entering Individual Punch List lines. 

Punch Lists records have a separate selection of Locations than the rest of the Project, to add a building 
and room to the Punch List, follow these steps. 

1. Right-Click in the Locations section of the Details table, and click “Add Location” 

 

Add Location Right-Click menu, with Locations area shown. 

2. Type in the name of the Building where the work is being performed, for example “120 
Ashford” 

3. Right Click on the Location Name you created in Step 2, to open the location menu, and click 
“Add Sub Location” 
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Right Click menu with “Add Sub Location” highlighted. 

4. Type in the room where you need to add Punch List items, for example “Room 205” 

 
Room added to Punch List Location List 

5. Repeat steps 4-5 for each room in the Project you have Punch List tasks for. 
Note: You can have as many levels in your list as you would like to manage the Punch List by.  
These are created as “Groups” in the Punch List line items and can be organized as such. 
Note 2: Once a Location has been added to a single Punch List for a Project it will then be 
available to all Punch Lists for that Project. 

6. Drag the location for the first punch list line from the Left-Hand Location list, to the Punch 
List items on the Right-Hand Side. 

 
Dragging a location from the list to the Punch List items. 

7. Highlight the line you created and click the “Edit” button. 

 
Edit button indicated. 

8. In the Description field enter the punch list task. 
9. The Trade drop down is not being used yet. 
10. In the Assigned To drop-down select the Project Team member who is in charge of this task. 

Note: This selection is made up of users or contacts in projects@BU.  If the assigned 
person is not a contact, then the name in this field should be the General Contractor. 

 
Assigned To drop-down opened. 

11. In the Issued Date field select the date the issue was discovered. 
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12. Issued date calendar opened. 

13. In the Received From field select the name of the person who discovered the Punch List 
issue. 

14. Enter the Due Date into the field. 
15. Click the “Update Records” button at the top left of the list. 

 

Update records button. 

16. Repeat steps 13 – 22 for each additional line in the Punch List. 
Note: The system keeps track of both the current date, and the Due Date of the 
tasks.  
Note: The Punch List item list, can be sorted just like any other list in projects@BU.  
This list can also be grouped by the various locations that were created in step 12. 

 

Completing Punch List Lines 

Once a Punch List line has been completed, navigate back to the list it was created on to close 
the line in the list. 

17. Select the line that was completed and click the “Edit” button in the toolbar 

 

Line selected, “Edit” button highlighted. 
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18. Scroll to the far right of the list. In the Completed field enter in the date the task was 
completed. 

19. If there is an additional cost associated with the completion of this line, that you would like 
to track, enter it into the Cost field, and then select the name of the contact it was Charged 
To from the drop-down list. 

 

Cost and Charged to fields. 

20. If you are the BU Project Manager, click the Closed check box, once you are sure the task has 
been completed.  If you are not the BU Project Manager, alert them that the task is done. 
The BU Project Manager will the verify completion, and click the check box, closing the line. 

21. Click the “Update Records” button to save your changes to this line of the Punch List. 
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